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Introduccion

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacién
creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guia de introduccion, aprendera los conceptos basicos del uso de las principales funciones de
Harmony Essentials, que le permitirdn ponerse al dia répidamente. Consulte la documentaciéon completa de
Toon Boom Harmony Essentials disponible en linea en docs.toonboom.com para aprender acerca de todas las

herramientas y opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/

Capitulo 1: Creacidn de una escena

Capitulo 1: Creacion de una escena

Aliniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:
¢ Crear escenas
e Seleccionar la resolucion de la nueva escena
¢ Administrar los valores predeterminados de la resolucion de la escena
« Abrir rdpidamente escenas recién abiertas
e Examinar y abrir una escena creada
e Ver tutoriales en video de Harmony en la web

e Acceder a la pagina web de soporte

Abrir una escena
Creary nombrar reciente

una escena

] Crear o eliminar un
Selec:_:]onar la valor predefinido de
resolucion de la o . resolucidn de una
escena Vidths 1520 escena

-, Get Help
”" ‘ — Examinar y abrir
.A. Open... una escena

Ver tutoriales en video de Obtener soporte
Harmany para Harmaony

Creacidn de una escena desde la pantalla de bienvenida

1. Enelcampo Name (Nombre), escriba el nombre de la escena.
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NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&A%!.

2. Para decidir en qué directorio se va a crear la escena, haga clic en el botén Browse (Examinar) junto
al campo Location (Ubicacién).

4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicacion principal aparecera con la nueva escena
abierta.
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Capitulo 2: Introduccion a la interfaz de usuario de Harmony

El uso de Toon Boom Harmony Essentials serd mucho mas fécil si primero se familiariza con su interfaz de
usuario. En el siguiente capitulo se proporciona una introduccion basica a los elementos mas importantes de la
interfaz de usuario. A medida que avance por los capitulos, conocerd mas detalles sobre cada uno de estos
elementos.

Aliniciar Toon Boom Harmony Essentials por primera vez, se presenta el espacio de trabajo predeterminado.
La zona de trabajo se divide en interfaces de usuario rectangulares denominadas vistas, cada una de ellas con
su propio fin especifico. Los laterales superior e izquierdo de la interfaz de usuario, asi como algunas vistas,
también contienen barras de herramientas, cada una con funciones especificas.

[ Vista de
propiedades de la
herramienta

Barra de |4
herramientas de
herramientas

Vista de color

Vista de camara

Barra de
herramientas de
reproduccion 1 Vista de linea de
tiempo
Vistas

Las vistas son pequenas interfaces de usuario con fines especificos. Se pueden agregar a la ventana principal
de la aplicacidn, en cuyo caso estan "ancladas" o se pueden abrir como ventanas separadas.

Cada vista tiene una pestafia con su nombre en la parte superior. Las pestainas no solo se pueden utilizar para
identificar las vistas con las que esta trabajando, sino que también le permiten apilar varias vistas en la misma
area de la interfaz de usuario. Por ejemplo, en la zona de trabajo predeterminada, la vista de camara ocupa la
mayor parte del drea. En la parte superior de la vista de cdmara hay dos pestafias: Camera (Camara) y
Drawing (Dibujo). Esto se debe a que la vista de dibujo esta apilada con la vista de cdmara y puede cambiar
répidamente entre ambas haciendo clic en cualquiera de las pestafas.

Agregar vista

[Cambiarvista] [ Cerrar vista l

Camera
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A la derecha de las pestafias de cada divisién de la zona de trabajo se encuentran los botones == Add View
(Agregar vista) y| % Close View (Cerrar vista), que le permiten apilar mds vistas o eliminar la vista
seleccionada de esta area de la zona de trabajo.

Adicidn de una vista

Puede agregar, eliminar, mover y apilar vistas en toda la zona de trabajo para optimizar el flujo de trabajo.

Adicion de una vista al espacio de trabajo como una pestana

1. En la esquina superior derecha de una vista existente, haga clic en el botén #= Add View (Agregar
vista).

Tool Properties

bstitutions

Brush Fixed Width 1
1

Brush Fixed Width 2
10

2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestana en la seccidn del espacio de trabajo donde la agregd.
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Tool Properties  Library |~ Top | Layer Properties | =%

Transformation | Drawing

NOTA

Algunas vistas, como la de camara, se pueden abrir en varias instancias. Por ejemplo, puede
resultar Util si desea tener dos instancias de las vistas de camara abiertas, cada una centrada
en distintas areas de la escena, para cambiar rapidamente entre los trabajos de estas dos

areas.

Adicidn de una vista a la zona de trabajo como una ventana

1. Abra el mend Windows (Ventanas).
2. En el mend Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecera como una nueva ventana sobre la ventana de la aplicacién principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre la vista flotante por la pestana y realice una de las siguientes acciones:
* Coloque la ventana sobre otra pestana para agregarla a ese conjunto de pestanas.

¢ Coloqgue la ventana por encima, por debajo o junto a una vista existente. Al acercarse
al borde de una vista, aparece un rectangulo cian que indica dénde se anclara la vista.

10
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sheet —] [m) s

5
Bru —_—
10

Brush 3

Aqui se proporciona una breve introduccién a cada una de las vistas mas utilizadas en Harmony.

Vista de camara

La vista de cdmara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacidn.

La vista de cdmara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en la vista, cambiar el modo de visualizacién o subir la jerarquia de simbolos.

11
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Pila de edicidn

Barra de herramientas de
camara
Modo de vista | Modo de vista
de OpenGL J| de render
I Mesa de luz ] Meni de zoom Nombre de [ Color seleccionado ]
__ i Espacio de color de vista '
Dibujo aclual encima I I Mostrar instantdnea previa
Mascara de camara I ] Tomar instantanea
I Zona segural I Restablecer vista
[ Mostrar guias de alineacién " Trazar dibujos bloqueados I

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cdmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores
descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo
seleccionada actualmente.

12
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Barra de herramientas de vista de dibujo

Camera Drawing =%

Areade
dibujo

Nombre del dibujo Nombre de herramienta Nimero de fotograma | | Posicion del cursor Selector de color

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mas comunes relacionadas con
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de
herramientas, se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrara
las opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno),
Apply to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

13
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Posibles opciones y
modos para la
herramienta actual

Fosibles operaciones
para la herramienta
actual

Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista
de color también es necesaria para dibujar, pintar y crear estilos de color.

[ Quitar paleta I [ Importar paleta I

[ Meni de vista de colorl [ Agregﬁrpﬁletﬁl [Bﬁjﬁr,’subirpﬁletﬁ I

Tolour 4%

[ Contraerfexpandir lista de paletas A

Scene Palettes

—[ Lista de paletas

[ Agregar muestra de color

[ Quitar muestra de color

[ Agregar textura

[ Muestra de color

'—[ Lista de muestras de colores

—_—
|
 —
—
 I—
 I—
—1
|
—
—1
 I—
—
|
=
 —
 —
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Vista de linea de tiempo

Para establecer el tiempo de la animacidn, trabajard principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy util familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

La vista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas
clave, duracién de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

LHabiIitan'deshabilih'cma )

[ Habilitar/deshabilitar modo Solo ] [Aﬂregarcapa ]

[Agregan'quitarpapeloebnlla I [E|iminarcapa I

[ Bloguear/desbloguear capa I [ Agregar capa de dibujo I

I Agregar peg

[ Alternar modo de contorno

[Mostran'ocultarima'genesen minizuE I [ Raarei | [ Cursor delinea de tiempo I[ Exposicién de dibuo I

++

++++

[Expandir.l’onntraergrupn I Coord dasenel

I fotograma actual [ Zoom de linea de tiempo I [ Fotograma clave de funcidn I

Mostrariocul
tar vincul
adicicnales

[ Expandiricontraer jerarquia de capas

Mostrariocul || Ndmero de dibujo
tar en el fotograma actual

F

[ Mostrar/ocultar parametros I

La vista de linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la
escena en su forma mas simple. También puede ver las capas y sus nombres, asi como la exposicion del
dibujo. EL nombre del dibujo se muestra al colocar el puntero sobre la exposicién del dibujo.

Vista de sustituciones de dibujo

La vista de sustituciones de dibujo le permite ver todos los dibujos de la capa seleccionada en una lista de
imagenes en miniatura, asi como seleccionar rapidamente qué dibujo se debe exponer en el fotograma actual.

15
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h Tool Properties  Library | Drawing Substitutions | 4|3

— - e
blsqueda
| Imégenes
miniatura
Contral

Animation

deslizante de
zoom

Nombre de capa actual

Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostrandolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo
expuesto mostrado por su nombre en las celdas. Se pretende que funcione como una carta de exposicién de
animacién tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacién tradicional y sin papel, mientras que la vista de linea de
tiempo se optimiza para una animacion digital o cut-out.

16
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I Barra de herramientas de carta de rodaje

I Encabezado de columna

Dibujo actual
Fotograma actual

13.577
13.561
13.544
13.528
13.511 !
I Exposicidn de dibujo 13.494 7 .

13.478 kz J o

Panel principal Panel de funciones

13.395 3.946
13.378
13.362
13.345
13.329
13312
13.295
13.279
13.262
13.246
13.229

Current: 1: A

I Numeros de fotograma I Lo Columna de Aumentarredudr Modo de
Dibujo/elemento actual funcidn oo . Pl

tar

Vista de libreria

La vista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imdgenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una
estructura de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee de
la plantilla en una libreria. La plantilla resultante se estructura como una miniescena que solo contiene los
elementos que copid en ella. Una plantilla no tiene ninguna dependencia en la escena en la que se cred
originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Ademas, el panel Drawing Substitutions (Sustituciones de dibujo) de la vista de libreria permite cambiar
rapidamente la exposicion del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
cut-out, que suelen contener varios dibujos donde elegir.

17
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-
&>
Vista previa de -
imagen en a
miniatura ﬁ
Nombre del dibujo * Lista de

recursos

I MNombre del elemento/recurso

Control deslizante de
sustituciones de dibujo

I Barra de blisqueda

Lista de carpetas de
libreria

I 'El campo del nombre del dibujo sclo aparece si se selecciona un elemento de la escena.

Barras de herramientas

La interfaz de Harmony contiene barras de herramientas que proporcionan acceso rapido a muchas
herramientas Utiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas se dividen en dos categorias principales:

* Las barras de herramientas de la zona de trabajo son barras de herramientas con un propdsito general.
Por ejemplo, las barras de herramientas File (Archivo), Edit (Edicidn), Workspace (Zona de trabajo) y
Deformation (Deformacion) en la parte superior, asi como la barra de herramientas Tools
(Herramientas) en la parte izquierda, son barras de herramientas de zona de trabajo. Esas barras de
herramientas se pueden colocar en el borde superior, inferior, izquierdo o derecho de la ventana de la
aplicacidn. Si se prefiere, también se pueden colocar en el borde de vistas especificas.

» Las barras de herramientas de vista son barras de herramientas Utiles para una vista especifica. Por
ejemplo, la vista de cdmara tiene una barra de herramientas de cdmara en la parte superior. Las barras
de herramientas de vista solo se pueden mostrar dentro de su vista respectiva. Se pueden colocar en el
borde superior, inferior, izquierdo o derecho de su vista.

Adicién de barras de herramientas

Adicidn o eliminacion de la barra de herramientas de una zona de trabajo a la zona de
trabajo general

1. Realice una de las siguientes acciones:

* En el mend superior, seleccione Windows > Toolbars (Ventanas > Barras de herramientas)
y, en el submend, seleccione la barra de herramientas que desee agregar.

18
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» Haga clic con el botén derecho en cualquier barra de herramientas situada en la parte
superior o lateral de la zona de trabajo o en la zona vacia junto a estas barras de
herramientas, y seleccione la barra de herramientas que desee agregar en el menu

contextual.

Haga clic con el botén
derecho en esta drea
para agregar o
eliminar barras de
herramientas.

Adicidn de una barra de herramientas de vista a una vista

1. Realice una de las siguientes acciones:

¢ Haga clic en la pestaia de la vista para la que desea agregar una barra de herramientas para
centrarse en ella. A continuacidn, en el menu superior, seleccione Windows > Toolbars
(Ventanas > Barras de herramientas) y seleccione la barra de herramientas que desee

agregar.

19



Capitulo 2: Introduccidn a la interfaz de usuario de Harmony

@ NOTA

En la lista de barras de herramientas del menu superior y el menu contextual de
la zona de trabajo, las barras de herramientas enumeradas por encima del
separador son barras de herramientas de la zona de trabajo y las que estan
debajo del separador son barras de herramientas de vista.

Workspace
| toolbars

View
toolbars

* En el area superior de la vista a la que desee agregar una barra de herramientas, a la
izquierda de la pestafa, haga clic con el botdn derecho y seleccione la barra de herramientas
que desee agregar en el menu contextual.

Haga clic con el botén derecho
en el drea izquierda de la
pestaria de |a vista de camara
para agregar una barra de
herramientas a la vista de
camara.

Dado que la vista de camara
ya dispone de una barra de
herramientas, también puede
hacer clic con el botén derecho
en ella para agregar barras de
harramientas a la vista de
camara o eliminarlas de la
misma.

20
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NOTAS

» En la lista de barras de herramientas del menu contextual de una vista, las
barras de herramientas enumeradas por encima del separador son barras de
herramientas de la zona de trabajo y las que estan debajo del separador son
barras de herramientas de vista.

v Camera Vi l—i Barras de
- herramientas
de vista

Barras de
herramientas
de la zona de
frabajo

* Siselecciona una barra de herramientas de la zona de trabajo en el menu
contextual de una vista, esta barra de herramientas de la zona de trabajo se
agregara a la vista. Si ya estaba presente en la zona de trabajo, se eliminara
de su ubicacion anterior.

e Cuando se agrega una barra de herramientas de la zona de trabajo a una
vista que tenga apiladas otras vistas, dicha barra de herramientas sera visible
en todas las vistas apiladas en la misma zona. Por ejemplo, si agrega la barra
de herramientas de animacién avanzada a la vista de cdmara, también serd
visible en la vista de dibujo.

Desplazamiento de una barra de herramientas

1. Haga clicy mantenga pulsado el controlador situado a la izquierda de la barra de herramientas que
desee mover.

2. Realice una de las siguientes acciones:

» Sila barra de herramientas es horizontal, muévala hacia arriba o hacia abajo para sacarla de

su fila.

21
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» Sila barra de herramientas es vertical, muévala hacia la izquierda o hacia la derecha para
sacarla de su columna.

3. Realice una de las siguientes acciones:

e Para reorganizar las barras de herramientas, arrastre la barra de herramientas hasta donde
desee y coléquela.

La barra de herramientas se moverd a su nueva posicion. Las barras de herramientas
situadas a la derecha (o en la parte inferior, si la barra de herramientas es vertical) se
desplazardn para dejar espacio.

e Para mover la barra de herramientas a una nueva fila o columna, simplemente mueva la
barra de herramientas donde se deba crear la nueva fila o columna. Por ejemplo, para crear
una nueva fila de barras de herramientas en la parte superior de la interfaz de usuario,
muévala justo debajo de las barras de herramientas existentes en la parte superior de la
interfaz de usuario. Aparecerd una nueva fila o columna resaltada en cian.

Al colocar la barra de herramientas, se creara la nueva fila y la barra de herramientas se
colocard en el extremo izquierdo de esta.

Del mismo modo, para crear una nueva columna a la izquierda de la interfaz de usuario,
muévala justo a la derecha de las barras de herramientas existentes a la izquierda de la
interfaz de usuario.

» Para mover la barra de herramientas a otro extremo de la interfaz de usuario, arrastrela
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hasta dicho extremo.

Desplazamiento de una barra de herramientas sobre otra barra de herramientas

1. Asegurese de que ambas barras de herramientas se encuentren en la misma fila o columna. Si no lo
estan, mueva ambas barras de herramientas a la misma fila o columna siguiendo el método
descrito anteriormente.

e Sjlas barras de herramientas son horizontales, haga clic y mantenga pulsado el controlador
de la izquierda de la barra de herramientas situada mas a la derecha. A continuacién, sin salir
de la fila de la barra de herramientas, deslice la barra de herramientas hacia la izquierda.

* Silas barras de herramientas son verticales, haga clic y mantenga pulsado el controlador de
la parte superior de la barra de herramientas inferior. A continuacion, sin salir de la columna
de la barra de herramientas, deslice la barra de herramientas hacia arriba.

A medida que desliza la barra de herramientas sobre la otra barra de herramientas, los botones de
la otra barra de herramientas se ocultan y aparece un botén de menu emergente.

[ e

Ment emergente para los
botones ocultos
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2. Para separar de nuevo las barras de herramientas, simplemente deslice la misma barra de
herramientas en la direccidn opuesta.

3. Para expandir una barra de herramientas que tenga superpuesta otra barra de herramientas, haga
clic en el botdn de expansidn situado a la derecha de la barra de herramientas superpuesta.

Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en
Harmony. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde
izquierdo de la ventana de la aplicacion.

Algunos de los botones de la barra de herramientas de herramientas disponen de un triangulo en la esquina
inferior derecha. Es para indicar que hay varias herramientas apiladas en este botdn. Para acceder a estas

herramientas, haga clic y mantenga pulsado el botdn de herramienta, o seleccione la herramienta y haga clic
de nuevo.

Una flecha en la esquina indica que hay mas
herramientas disponibles en un mend
emergente.

Seleccionar

Editor de contorno
* Brush
Pincel
ncil Brush

Sello
Borrador
Texto

e w Paint
Pintar w Paint Unpainted

] #$ Hand w Unpaint
[ Cuentagotas de color ’ _ -

=

o
=4

N

Mango *C

[ Modo Animate (Animar) rent Frame

Transformar

Fapelcebolla
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CONSEJO

Muchos botones de la barra de herramientas disponen de un atajo de teclado asociado. Puede
comprobar qué atajo de teclado estd asociado a un botdn dejando el cursor del ratdn sobre el

botén durante un segundo. Si el botdn tiene un atajo de teclado, se indicara en la informacion

sobre herramientas que aparece.

Brush (Alt+B)
Create lines or areas like a paint brush.

Barra de herramientas de archivo

La barra de herramientas de archivo contiene botones para operaciones de archivo comunes, como New
(Nuevo), Save (Guardar) y Open (Abrir). Estos comandos también se encuentran en el menu superior File
(Archivo).

Barra de herramientas de edicidn

La barra de herramientas de edicién contiene operaciones comunes como Undo (Deshacer), Redo (Rehacer),
Cut (Cortar), Copy (Copiar) y Paste (Pegar). Estos comandos también se encuentran en el menu superior Edit
(Editar).

I Corlar] ICopiar I

Crear simbolo

Barra de herramientas de reproduccion

La barra de herramientas de reproduccién le permite reproducir la animacion, asi como configurar algunas
opciones de reproduccion, como bucle, reproduccion de audio, rango de reproduccion y velocidad de
reproduccion.
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[ Desplazar fotogramas

[ Renderizar y reproducir ] [ Habilitar depuracién de sonido ]

[ Bucle ] [ Habilitar sonido ]

Navegacidn por la interfaz

Con la ayuda de comandos de menu y atajos de teclado, algunas vistas permiten navegar por su contenido al
acercarlo, alejarlo, panearlo y rotarlo. También puede restablecer el nivel de zoom, el paneo y el angulo de
rotacion de estas vistas seguin sea necesario.

Los comandos de navegacion de la tabla que se muestra a continuacidon se pueden utilizar en las siguientes
vistas, con algunas excepciones:

e Cadmara

¢ Dibujo

e Linea de tiempo
e Carta de rodaje
* Funcion

e Lateral y superior

“/~- CONSEJO

o’ ~

Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para
Harmony en el cuadro de didlogo Keyboard Shortcuts (Atajos de teclado). Para acceder al cuadro
de didlogo Keyboard Shortcuts (Atajos de teclado):

* Windows: en el menu superior, seleccione Edit > Keyboard Shortcuts (Editar > Atajos de
teclado).

* macOS : en el menu superior, seleccione Harmony Essentials > Keyboard Shortcuts
(Harmony Essentials > Atajos de teclado).

Comando Accién Métodos de acceso

View > Zoom In (Ver > Acercar)
Zoom In (Acercar) Acerca la vista.
Pulse 2.
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Comando

Accidén

Métodos de acceso

Gire la rueda del ratén hacia arriba (excepto en las vistas de
linea de tiempo y de carta de rodaje)

Zoom Out (Alejar)

Aleja la vista.

View > Zoom Out (Ver > Alejar)
Pulse 1.

Gire la rueda del ratén hacia abajo (excepto en las vistas de
linea de tiempo y de carta de rodaje)

Zoom In 0 Zoom
Out (Acercar o
Alejar)

Acerca o aleja la vista.

Gire la rueda central del ratén hacia arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y la rueda central del
ratén mientras arrastra el ratén hacia arriba o hacia abajo.

Pan (Panear)

Mueve la vista horizontal
o verticalmente.

Mantenga pulsada la barra espaciadora y arrastre en la
direccién que desee panear la vista.

(Restablecer vista)

posicién predeterminada.

Reset Pan Restablece el paneo de View > Reset Pan (Ver > Restablecer paneo)
(Restablecer vista a su posicién
paneo) predeterminada. Pulse Mayds + N.

View > Reset View (Ver > Restablecer vista)
Reset View Restablece la vista a su Pulse Mayus + M.

El botén @ Reset View (Restablecer vista) en la parte
inferior de la vista de cdmara.

Reset Rotation

Restablece la rotacién de

View > Reset Rotation (Ver > Restablecer rotacién)

(Restablecer vista a su posicién
rotacion) predeterminada. Pulse Mayus + X.
Reset Zoom Restablece el zoom de
(Restablecer vista a su posicion View > Reset Zoom (Ver > Restablecer zoom)
zoom) predeterminada.
. Mientras mantiene pulsadas las teclas Ctrl + Alt
Rotate View . . . .
(Rotar vista) Rota la vista . (Windows/Linux) o Ctrl + 8 (macQOS), haga clicy arrastre el
otar vista
disco de rotacién para rotarlo a la derecha o a la izquierda.
Rotate 30 CW Rota la vista de camara . . .
View > Rotate View CW (Ver > Rotar vista der.)
(Rotar 30 der.) 30 grados a la derecha,
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Comando

Accién

Métodos de acceso

como una mesa de
animacion.

Rotate 30 CCW
(Rotar 30 izq.)

Rota la vista de camara
30 grados a la izquierda,
como una mesa de
animacion.

View > Rotate View CCW (Ver > Rotar vista izq.)

Mirror View (Vista
de espejo)

Cambia temporalmente
la vista de camara o de
dibujo en horizontal, lo
que permite ver y editar
la ilustraciéon como si se
estuviera reflejando.

View > Mirror View (Ver > Espejo)

En la barra de herramientas de cdmara o de dibujo, haga clic
en el botdn Mirror View (Espejo) Q .

Toggle Quick
Close-up (Alternar
primer plano
rapido)

Multiplica
inmediatamente el factor
de zoom de la vista por 4.
Por ejemplo, si el factor
de zoom de la vista de
camara se encuentra al
100 %, esto hara que
alterne entre 400 % vy
100 %.

Mayus +Z

Toggle Full Screen
(Alternar pantalla
completa)

Pasa por los siguientes
modos de visualizacion:

* Normal Full-
Screen (Pantalla

completa normal):

la ventana
principal de la
aplicacion se
convierte en
pantalla
completa.

¢ View Full-Screen
(Ver pantalla
completa): la vista
seleccionada se
convierte en
pantalla completa

View > Toggle Full Screen (Ver > Alternar pantalla
completa)

Pulse Ctrl + F (Windows/Linux) o % + F (macOS).
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Comando Accién Métodos de acceso

y todas las demas
vistas se
contraen.

* Normal: la
ventana principal
de la aplicacion se
restaura a su
tamaiio original y
las vistas
contraidas se
expanden.

Interfaz tactil

Si estd trabajando con una pantalla tactil, un trackpad o una tableta que admita funcidn tactil, también puede
utilizar los gestos de dos dedos estandar para el zoom, la rotacidn y el paneo en las vistas de camara y dibujo.
Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacion del soporte de gestos

1. Enel menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o
Harmony > Preferences (Harmony > Preferencias) (Mac OS X).

2. Abra la pestana General.

3. Enla seccién Touch Interface (Interfaz tactil), marque la casilla de verificacién Support Gestures
(Soporte de gestos).

4. Haga clic en OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de cdmara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.

Uso de gestos

1. En la vista de cdmara o de dibujo, presione con dos dedos situados a una distancia corta entre si.
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2. Realice una de las siguientes acciones:

» Para panear la vista, arrastre los dos dedos en cualquier direcciéon, manteniéndolos a la
misma distancia uno del otro.

e Para acercar el zoom, arrastre los dos dedos separando uno del otro.

e Para alejar el zoom, arrastre los dos dedos acercando uno al otro.

e Para rotar, arrastre los dos dedos haciendo una curva para que giren en la misma direccion.
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Capitulo 3: Adicion de capas

Aligual que con la animacidn tradicional, Harmony utiliza capas para mantener los elementos, como
personajes, fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendrd una capa predeterminada denominada Drawing (Dibujo) en la

que se puede comenzar a dibujar de inmediato.

Capa de dibujo
predeterminada

Las capas se pueden seleccionar y gestionar en la vista de linea de tiempo. Una escena puede tener tantas
capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre

las capas inferiores.

Y R T— :

Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En
Lla animacién tradicional, es comin nombrar a las capas de animacion con letras individuales (A, B, C, etc.) y las
capas de disefio con acrénimos (BG para fondo, OL para superposicidn, etc.). Asi, puede comenzar la escena

dando a la primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de linea de tiempo

1. En la vista de linea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

Aparece un campo de entrada de texto sobre el nombre.
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2. Escriba el nuevo nombre de la capa y pulse Intro/retorno.

La capa tiene un nuevo nombre.

nO=am

o

Adicion de capas

Adicién de un elemento de dibujo desde la vista de linea de tiempo

1. Realice una de las siguientes acciones:

» En la vista de linea de tiempo, haga clic en el botén % Add Drawing Layer (Agregar capa de
dibujo).

* En el mend superior, seleccione Insert > Drawing (Insertar > Dibujo).

e Pulse Ctrl + R (Windows/Linux) o 8 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa.

3. Realice una de las siguientes acciones:

» Haga clic en Add (Agregar) para crear esta capa, pero deje abierto el cuadro de didlogo para
poder crear mas capas.

* Haga clic en Add and Close (Agregar y cerrar) para crear esta capa y cerrar el cuadro de
diadlogo.
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Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

Eliminacidn de capas

Eliminacion de capas en la vista de linea de tiempo

1. En la vista de linea de tiempo, seleccione las capas que desea eliminar.

NOTA

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayus,
haciendo clic en la primera capa que desee seleccionar vy, a continuacion, en la ultima.
También puede seleccionar varias capas manteniendo pulsada la tecla Ctrl
(Windows/Linux) o 8 (macOS) y haciendo clic en cada capa que desee seleccionar.

2. Realice una de las siguientes acciones:

» En la barra de herramientas de capa de la vista de linea de tiempo, haga clic en el botén =—
Delete Layers (Eliminar capas).

» Haga clic con el botén derecho en la seleccién y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de linea de tiempo.
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Cambio de orden de capas

Reorganizacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione las capas que desea mover.

2. Haga clicy arrastre la seleccidn, y realice una de las siguientes acciones:

» Coloque la seleccion entre dos capas para moverla entre ellas. Aparecera una linea cian
entre las capas donde se movera la seleccion.

rnosam

» Coloque la seleccidn en una capa para aplicar un rig de las capas seleccionadas como hijas
sobre esa capa.

Agrupacion de capas
La agrupacidn de capas permite mantener la estructura de la escena organizada.

Ademas, puede colocar varias capas dentro de un grupo y, a continuacion, agregar un efecto en este grupo
para aplicarlo en todas las capas del mismo.
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Agrupacidn de capas en la vista de linea de tiempo

1. En la vista de linea de tiempo, seleccione los elementos que desee agrupar.

NOTA

Las capas que se encuentren entre las seleccionadas se agruparan con las capas
seleccionadas.

2. Realice una de las siguientes acciones:

» Haga clic con el botén derecho en las capas resaltadas y seleccione Group Selection
(Agrupar seleccién).

» Pulse Ctrl + Mayus + G (Windows/Linux) o $# + mayusculas + G (macQOS).

Se agrega una nueva capa de grupo a la vista de linea de tiempo.

Si hace clic en el botdén Expand Group (Expandir grupo), encontrara las capas agrupadas en rig
como hijos de la capa de grupo.

Ocultar y visualizar capas

Puede ocultar capas temporalmente para que no desordenen la vista de cdmara mientras trabaja en otras
capas.
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Cdémo ocultar una capa en la vista de linea de tiempo

1. En lavista de linea de tiempo, a la izquierda de la capa que desea ocultar, haga clic en el botdn (¢4
Disable Layer (Deshabilitar capa).

La capa se volvera invisible en la vista de camara.

2. Sidesea mostrar la capa, haga clic en el botén “ Enable Layer (Activar capa) para volver a
mostrarla.

Bloqueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas bloqueadas se pueden editar en la vista de linea de tiempo o
de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de cdmara. Esto puede
ser Util para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o
personajes con los que no esté trabajando actualmente.

Bloqueo de una capa en la vista de linea de tiempo

1. En lavista de linea de tiempo, a la izquierda de la capa que desea bloguear, haga clic en el botén
E Lock (Bloguear).

Sera imposible seleccionar la capa o dibujar en ella en la vista de camara. EL nombre de la capa
aparecera en rojo en la vista de linea de tiempo.

2. Sidesea desbloquear la capa, haga clic en el botén Unlock Layer (Desbloquear capa) para

volver a mostrarla.
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Capitulo 4: Como dibujar

Cuando crea una escena, la escena incluye una capa de dibujo predeterminada en la que puede comenzar a
dibujar de inmediato.

NOTA

Segun su estilo de dibujo y con lo que se sienta cdmodo, es posible que prefiera trabajar con la
herramienta Brush (Pincel) o la herramienta Pencil (Lapiz). Para obtener mds informacion sobre la
diferencia entre estas dos herramientas, consulte Cuando crea una escena, la escena incluye una

capa de dibujo predeterminada en la que puede comenzar a dibujar de inmediato. en la pagina 39.

Dibujo con la herramienta Brush (Pincel)

1. En la vista de linea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de
dibujo.

2. Sidesea dibujar con la herramienta Brush (Pincel), realice una de las siguientes acciones:
e En la barra de herramientas de herramientas, seleccione la herramienta &~ Brush (Pincel).
* En el menu superior, seleccione Tools > Brush (Herramientas > Pincel).
* Pulse Alt + B.

Si desea dibujar con la herramienta Pencil (Lapiz), realice una de las siguientes acciones:

» En la barra de herramientas de herramientas, seleccione la herramienta # Pencil (Lapiz).
* En el mend superior, seleccione Tools > Pencil (Herramientas > Lapiz).
e Pulse Alt +/.

3. Enlalista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione
un pincel o lapiz predefinido que desee utilizar.
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4. Utilice el control deslizante Maximum Size (Tamano maximo) para seleccionar el tamafo deseado
para el pincel o lapiz.

5. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mas informacidn sobre la creacidn y edicién de colores, consulte Creacidn o edicidn de muestras de

colores en la pdagina 51.

W Palettes

Scene Palettes

[Adlw ]

7. Siesta utilizando la herramienta Brush (Pincel) y desea realizar cambios en su pincel, en la vista de
propiedades de la herramienta, haga clic en el botdn de flecha para abrir el cuadro de didlogo
Brush Properties (Propiedades del pincel). En este cuadro de didlogo, puede personalizar el
tamano, la forma y el suavizado del pincel.

. /\/ n
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CONSEJOS

Puede ajustar rapidamente el tamano de la herramienta de dibujo seleccionada
manteniendo pulsada la tecla y, a continuacién, haciendo clicen lateclaOy, a
continuacidn, arrastrando en el espacio de dibujo. Si utiliza un lapiz de tableta, al hacerlo
con la punta del borrador del lapiz ajustara el tamarfio de la herramienta Eraser (Borrador),
independientemente de la herramienta de dibujo seleccionada.

Si mantiene pulsada la tecla Mayls antes de dibujar o mientras lo hace, dibujara una linea
recta.

Si mantiene pulsada la tecla barra espaciadora mientras dibuja una linea recta, se fijara el
angulo de la linea. Si utiliza una tableta sensible a la presién, puede dibujar sobre la linea
para ajustar su grosor.

Si mantiene pulsadas las teclas Mayus y Alt antes de dibujar o mientras lo hace, dibujara
una linea recta horizontal o vertical.

Si mantiene pulsada la tecla Ctrl (Windows/Linux) o 8 (macOS) mientras dibuja, su trazo
de dibujo se convertira en una forma cerrada.

Si mantiene pulsada la tecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un
dibujo existente, el comienzo del trazo se conectard con el otro dibujo.

Si mantiene pulsada la tecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro
dibujo existente, el final del trazo se conectara con dicho dibujo.

Ajuste de ilustracion

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el ultimo trazo, borrar partes de un

dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

Deshacer el ultimo trazo

1. Realice una de las siguientes acciones:

e En el mend superior, seleccione Edit > Undo (Editar > Deshacer).

e Pulse Ctrl + Z (Windows/Linux) o # + Z (macOS).

Cémo borrar

1. En la barra de herramientas de herramientas, seleccione la herramienta & Eraser (Borrador) o
pulse Alt + E.
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2. En la vista de dibujo o de camara, dibuje un trazo de borrador sobre las partes del dibujo que desee

borrar.

Manipulacidn de los trazos del dibujo

1. En la barra de herramientas de herramientas, seleccione la herramienta X Select (Seleccionar) o
pulse Alt + S.

2. En lavista de camara, seleccione los trazos que desee editar realizando una de las siguientes

acciones:
e Haga clic en un trazo para seleccionarlo.

» Mantenga pulsada la tecla Mayus mientras hace clic en un trazo para agregarlo a la

seleccidn.
* Dibuje un lazo alrededor de los trazos de dibujo para seleccionarlas simultdneamente.
3. Realice una de las siguientes acciones para editar la seleccidn:

e Para cambiar la ilustracién seleccionada de posicidn, haga clic en ella y arrdstrela a la
posicién deseada.

NOTA

También puede realizar un desplazamiento pequefio de la seleccidn con las
teclas de flechay, para realizar un desplazamiento rapido, mantenga pulsado
Mayus y pulse las teclas de flecha.

e Para rotar la ilustracion seleccionada, haga clic fuera de la imagen y coja uno de los
controladores en las esquinas del cuadro de control y rotela.
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e Para escalar la ilustracidn seleccionada, haga clic y arrastre uno de los puntos de control en
las esquinas o en el centro de los bordes del cuadro de control.

“(~. CONSEJO

4 \

Mientras escala la ilustracidn, puede conservar las proporciones manteniendo
pulsada la tecla Mayus.

e Para sesgar, arrastre hacia los lados o hacia arriba y abajo de los lados o los segmentos
superior e inferior, entre los puntos de control.
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e Para eliminar, pulse Supr (Windows/Linux) o retroceso (macQOS).

Cdmo cortar dibujos

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) 2 o
pulse Alt + T.

2. En lavista de cdmara o de dibujo, dibuje un lazo alrededor del trabajo que desea cortar.

El trabajo dentro del lazo que ha dibujado se cortara del resto del trabajo y se seleccionara.

_‘Q'_ CONSEJOS
» Puede agregar otra parte del trabajo a la seleccion manteniendo pulsado Mayus y

dibujando otro lazo.

e De forma predeterminada, la herramienta Cutter (Cuchilla) solo funcionara en la
capa actual. Puede cortar trabajos de todas las capas visibles manteniendo pulsada
la tecla Ctrl (Windows) o # (macOS).

3. Una vez que haya cortado la imagen, puede manipularla como con la herramienta Select
(Seleccionar). Por ejemplo:

» Para mover el trabajo seleccionado, haga clic y arrastrelo.
» Para eliminar el drea seleccionada, pulse Supr.

» Para escalar, rotar o sesgar la seleccidn, utilice los controles alrededor del cuadro
delimitador de la seleccion.
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[ Rotar Sesgar ] [ Escala | Sesgar LJ Rotar ]
d-"—"— l—Seam

— (o)

Sesgar || Escala || Sesgar

Cdmo recortar una sola linea

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o
pulse Alt + T.

2. Enlavista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de

cuchilla), seleccione el lazo
Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).
3. Seleccione el modo Single Line Cutting Gesture (Gesto de corte de una sola linea) *:.

4. En lavista de escena o de camara, deslice la herramienta Cutter (Cuchilla) por el extremo de una

linea que desee recortar.
El extremo de la linea desaparece.

Antes
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Después

NOTA

Incluso si el gesto del ratdn toca otras lineas, solo desaparece la primera linea con la que la
herramienta Cutter (Cuchilla) entra en contacto.
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Como recortar varias lineas

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o
pulse Alt + T.

2. Enlavista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de
cuchilla), seleccione el lazo

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).

3. Enlavista de propiedades de la herramienta, seleccione Multiple Lines Cutting Gesture Mode
(Modo de gesto de corte de varias lineas) 5 .

4. En la vista de escena o de camara, deslice la herramienta Cutter (Cuchilla) por el extremo de una
linea que desee recortar.

Los extremos de la linea desaparecen.

Antes

Después
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Capitulo 5: Como pintar

Toon Boom Harmony Essentials incluye algunas funciones de pintura muy Utiles para agregar color a los
dibujos. Mientras que otro software solo permite que los usuarios trabajen con muestras de color de una en
una, la pintura en Harmony se realiza con paletas que contienen varias muestras de color que se pueden
almacenar vy reutilizar segun sea necesario.

00 L TGO ] O

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y
modificarlas.

L

Cuando modifique el color de una muestra existente, se actualizaran automaticamente todas las zonas
pintadas con esta muestra en toda la escena. La muestra de color tiene un nimero de ID exclusivo que la
asocia con las zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento
sin necesidad de volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademas de la paleta habitual para un personaje, también puede tener una para ese personaje en la
lluvia con colores mas apagados y menos vivos que los colores de dias secos, o incluso otra para una escena
de noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacidn se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccién. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada drea que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este ultimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
» Cada personaje conserva permanentemente sus colores especificos.
* No puede usar por error un color que no esté en la paleta maestra.
» Estandarizacién y uniformidad del color durante la produccidn.
e Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite
un control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creard una nueva paleta
y agregara un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el
pelo, la lengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. En el mend de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botén
New Palette (Nueva paleta).

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta segiin el modelo.

New Palette Name | New_Palette

oK Cancel

3. Hagaclic en OK (Aceptar).

La paleta aparece en la lista de paletas.
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[Adlw ]

Creacion o edicidn de muestras de colores

1. Sidesea crear una nueva muestra de color, haga clic en el botén 4 Add Colour (Agregar color) en
la vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de
color.

2. Realice una de las siguientes acciones para editar la muestra de color:
* En el mend de vista de color, seleccione Colours > Edit (Colores > Editar).
e Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

3. Para definir el color, realice una de las siguientes acciones:

¢ Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation
(Saturacion) o Value (Valor) para cambiar el espectro del circulo cromatico vy, a
continuacion, haga clic en el color que desee en el circulo cromatico.

* Introduzca los valores de matiz, saturacién, valor, rojo, verde y azul de forma manual
en los campos correspondientes. Todos los valores oscilan entre O y 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él dreas de un
dibujo, todas las areas pintadas con este color en los dibujos se actualizardn al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cémo pintar dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. Enla barra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
Alt + 1.

3. Enla vista de color, seleccione una paleta del personaje.

4. Seleccione un color de la paleta.

W Palettes

Scene Palettes

[Adlw ]

5. En la vista de dibujo o de camara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas areas del dibujo no estaban completamente cerradas debido a
pequefos huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el drea, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible,
que la herramienta Paint (Pintar) considerara como una linea normal. En Harmony, las lineas invisibles
utilizadas para definir las areas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequenos huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente para rellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisidon. Solo tiene que dibujar un trazo basico junto al hueco para que se cree automaticamente una linea
vectorial transparente recta que conecte directamente un extremo del hueco al otro.

53



Capitulo 5: Cémo pintar

Uso de la herramienta Close Gap (Cerrar hueco)

1. Antes de trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo
o de camara. Puede habilitar la opcidon Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

* En el menu superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

e Pulse K.
2. Realice una de las siguientes acciones:

e En la barra de herramientas de herramientas , seleccione la herramienta ( Close
Gap (Cerrar hueco).

e En el mend superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

e Pulse Alt + C.
3. Enlavista de camara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opcion Close Gap (Cerrar hueco), que se
puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada,
Harmony intentara encontrar y cerrar automaticamente pequefios huecos cuando intente
rellenar una forma que no esté cerrada.
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Capitulo 6: Creacion de una animacion tradicional sin papel

Creacidon de un boceto de animacidn

El primer paso para crear una animacion sin papel es la creacién de un boceto, que es el esqueleto de la
animacién. Por lo general, empezaria animando la parte mds importante de la accién de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacion secundaria como la cabeza, los brazos y la ropa.

Para que la animacion sea satisfactoria, comience animando la accidn principal con esbozos basicos y rapidos
y, a continuacidén, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos
los detalles inmediatamente, perdera mucho tiempo en caso de tener que realizar correcciones, y es probable
que la animacién tenga una apariencia rigida.

Creacidon de un boceto de animacidn

1. En lafila superior de la vista de linea de tiempo, haga clic en m Show All Thumbnails (Mostrar
todas las imagenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

4‘
wOS AN

3

2. Enla barra de herramientas de herramientas, seleccione la herramienta &~ Brush (Pincel) o pulse
Alt + B.

3. Enlavista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para
el boceto de animacion. Esto facilitara el proceso de clean up, ya que las lineas oscuras y limpias
haran contraste con las lineas esbozadas claras.
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4. En la vista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el primer dibujo.

5. En la vista de cdmara o de dibujo, dibuje el primer dibujo clave.

6. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imagenes en miniatura
dentro de las celdas realizando una de las siguientes acciones:

e Arrastre el control deslizante _ Timeline Zoom (Zoom de linea de tiempo) hacia
la derecha.

» Haga clic en la pestafia de la vista de linea de tiempo y pulse 2 de forma reiterada.

* Mueva el cursor del ratdn en la vista de linea de tiempo, mantenga pulsado Ctrl
(Windows/Linux) o 8 (macOS) y gire la rueda del ratén hacia arriba.
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roSalM

7. Enlavista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.

8. Enla barra de herramientas de herramientas, haga clic en el botén é Onion Skin (Papel cebolla).
Esto mostrara los dibujos anteriores y siguientes en un color claro en la vista de cdmara o de dibujo,
detras del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos
con precision. Esta opcidn puede ser Util para dibujar poses de descomposicién entre dos poses
clave, o para agregar un dibujo intercalado entre otros dos dibujos.

[ Intervalo de dibujos mostrados en papel cebolla ]

9. Asegurese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

* En la vista de linea de tiempo, haga clic y arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clic y arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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e Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

e Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

e Para reducir la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén = Remove Previous Drawing (Eliminar dibujo anterior) en la barra
de herramientas de la vista de camara/dibujo.

e Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

e Para reducir la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn = Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

[ Intervalo de dibujos mostrados en papel cebolla I

10. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

* En la barra de herramientas de linea de tiempo o de carta de rodaje, haga clic en el
botén ¥ Create Empty Drawing (Crear dibujo vacio).

e Pulse Alt + Mayus + R.

11. Enlavista de camara o de dibujo, dibuje el segundo dibujo clave.
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13. Al usar los marcadores de papel cebolla, asegurese de que el papel cebolla cubra tanto el primer
como el ultimo dibujo.

[ Intervalo de dibujos mostrados en papel cebolla ]

14. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

» En la barra de herramientas de linea de tiempo o de carta de rodaje, haga clic en el
botén I Create Empty Drawing (Crear dibujo vacio).

e Pulse Alt + Mayus + R.

15. En la vista de camara o de dibujo, dibuje la nueva pose.

16. En la vista de linea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos
anteriores para cada nuevo dibujo.
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NOTA

Al trabajar con capas de superposicién en la vista de cdmara, puede habilitar la opcién £

Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de
camara para hacer que la capa en la que esta trabajando aparezca sobre las otras capas.

Revisidn de la animacion

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se estd trabajando conectan bien
entre si y crean la ilusién de movimiento adecuada. Puede desplazarse rapidamente por los dibujos con los

atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente.

Desplazamiento por los dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee

desplazarse.
2. Realice una de las siguientes acciones:
e Pulse F parair al dibujo anterior.
e Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atras o
hacia delante.

Cuando el boceto de animacion esté terminado, reprodtzcalo para asegurarse de que es lo que se esperaba

antes de continuar con el siguiente paso.

Reproduccidn de la animacién

1. En la vista de linea de tiempo, haga clic en el botén del modo @ Solo a la izquierda de cada capa
que desee ver durante la reproduccién en la vista de linea de tiempo para habilitar el modo @ Solo

en estas capas.

roSalM

Cuando una o mas capas tengan habilitado el modo Solo, Unicamente se mostraran las capas que

tengan este modo habilitado, y las otras capas quedaran ocultas.
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2. En lavista de linea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga
clic en el botdn Start (Iniciar) en la barra de herramientas de linea de tiempo. A continuacién,
mueva el cabezal al ultimo fotograma de la animacion y haga clic en el botdn Stop (Detener).

3. Enla barra de herramientas de reproduccién, haga clic en el botén O Loop (Bucle) para habilitar la

opcidn de bucle durante la reproduccidn.

4. En labarra de herramientas de reproduccién, haga clic en el botén » Play (Reproducir) para

comenzar la reproduccion.

Limpieza

Una vez que se haya completado el boceto de animacién, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
cerrar las zonas abiertas. Es el paso final de la animacidn sin papel antes del paso de ink and paint.

En una animacidn tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el
boceto debajo, que se puede ver con la mesa de luz del disco de animacién. Del mismo modo, en Harmony,
tendrd que agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando
haya terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animacion para
que no aparezca en la animacién final. Este enfoque también permite mantener los bocetos y los dibujos de
clean up intactos y administrarlos de manera independiente.

En la vista de cdmara, verd el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animacién mientras realiza

trazados en la capa de clean up.

Trazado de la animacidn en una nueva capa

1. En la vista de linea de tiempo, cambie el nombre de la capa en la que cred el boceto de animacién
haciendo doble clic en su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".
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2. En la vista de linea de tiempo, agregue una capa realizando una de las siguientes acciones:

» En la barra de herramientas de capas de la vista de linea de tiempo, haga clic en el
botén %% Add Drawing Layer (Agregar capa de dibujo).

e Pulse Ctrl + R (Windows/Linux) 0 # + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. Enelcampo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".
3. Hagaclic en Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

4. En la vista de linea de tiempo, haga clic en el icono Lock (Bloguear) de la capa que contiene el
boceto de animacidn para impedir que dicha capa se pueda seleccionar en la vista de camara.

5. En la vista de linea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que
corresponda al primer dibujo clave del boceto de animacidn.
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6. En la barra de herramientas de herramientas, seleccione una herramienta de dibujo, como la
herramienta # Pencil (Lapiz).

7. En la vista de color, seleccione un color para trazar la animacion. Seleccione un color oscuro
intenso, como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del
boceto de animacién.

8. En la vista de camara o de dibujo, comience a trazar el primer dibujo clave.

NOTA

Si las capas de superposicion estan en medio, puede deshabilitarlas
temporalmente haciendo clic en su botén (€4 Enable/Disable
(Habilitar/deshabilitar) en la vista de linea de tiempo para que solo se muestren
el boceto de animacién y las capas de clean up.

9. En la vista de linea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a
un boceto de dibujo.

10. En la barra de herramientas de herramientas, haga clic en el botén == Enable Onion Skin (Habilitar
papel cebolla) para habilitar el papel cebolla.

11. Asegurese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las
siguientes acciones:

» En la vista de linea de tiempo, haga clic y arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clic y arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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e Ultilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

e Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

e Para reducir la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén = Remove Previous Drawing (Eliminar dibujo anterior) en la barra
de herramientas de la vista de cdmara/dibujo.

e Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

e Para reducir la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén = Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

12. En la vista de camara, trace el siguiente dibujo.
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13. Repita los pasos anteriores para cada dibujo.
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Capitulo 7: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imagenes de vectores creadas dentro de su propia interfaz.
Las imagenes de vectores se componen principalmente de informacién sobre las distintas formas que
componen las imagenes, asi como de sus colores de linea y de relleno. Esto hace que sean faciles de editar y
pintar, y permite redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imagenes de
mapa de bits se componen de informacion de color sobre cada pixel individual que compone la imagen. Por lo
tanto, son mas adecuados para imagenes muy detalladas o realistas, pero no se pueden escalar sin perder
calidad de imagen.

Normalmente, es necesario trabajar con imagenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacién, puede importar los archivos de
imagenes de mapa de bits en su escena de Harmony.

Alimportar una imagen de mapa de bits, debe decidir cémo debe procesarla Harmony. Puede elegir entre las

siguientes opciones:

* Import as Bitmap (Importar como mapa de bits) : importa la imagen exactamente tal como estay
garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opcidn es util para utilizar
fondos creados en el proyecto con un software diferente.

¢ Vectorize (Vectorizar) : convierte un mapa de bits en un dibujo vectorial de Toon Boom que se puede
pintar y editar facilmente con las herramientas de dibujo vectorial de Harmony. Esta opcidn puede ser
util para la importacion de capa de lineas escaneadas o creadas con un software diferente.

Importacién de una imagen de mapa de bits en su formato original

1. Realice una de las siguientes acciones:

* En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

e En la barra de herramientas de archivo, haga clic en el botdn ‘i Import Images
(Importar imagenes).

» En la vista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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2. En la seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic
en Browse (Examinar) para buscar y seleccionar una o mas imagenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcién Create Layer(s)
(Crear capas) y una de las siguientes opciones:

* Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imagenes en ella.

* Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la "b" contendra la tercera.

» Add to a Existing Layer (Agregar a una capa existente): Importa las imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. En la seccion Vectorization (Vectorizacidn), asegurese de que la opcidn Vectorize Image (Vectorizar
imagen) no esté marcada.

5. Haga clic en OK (Aceptar).
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NOTA

De forma predeterminada, las imagenes de mapa de bits se mostraran en baja resolucion en la
vista de cdmara para evitar que afecten al rendimiento de la reproduccion. También puede
ajustar la calidad de visualizacidén de una imagen de mapa de bits seleccionandola con la
herramienta Transform (Transformar) y, a continuacion, abriendo el cuadro de didlogo Bitmap
Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa
de bits en la resolucion de la escena activando el modo Render Preview (Vista de render)
en la vista de cdmara.

Vectorizacion de imagenes

Harmony permite importar imagenes como dibujos de vectores. Los dibujos de vectores se pueden pintar y
editar facilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser (til para la
importacion de capa de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarla en
Harmony.

Importacion y vectorizacion de una imagen de mapa de bits

1. Realice una de las siguientes acciones:

* En el mend superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

* En la barra de herramientas de archivo, haga clic en el boton ‘iz Import Images
(Importar imagenes).

» En la vista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imdgenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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1. En la secciodn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic
en Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imagenes:

¢ Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imagenes en ella.

* Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la "b" contendra la tercera.

» Add to a Existing Layer (Agregar a una capa existente): Importa las imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. Enla seccidn Vectorization (Vectorizacidn), seleccione la opcidn Vectorize Image (Vectorizar
imagen).

4. Seleccione una de las siguientes opciones:

* Colour (Color): Importa mapas de bits como objetos de vectores con suimagen como textura
de mapa de bits. El dibujo resultante se puede dibujar o borrar, pero no se puede volver a
pintar o ajustar.

» Black and White (Blanco y negro): Vectoriza los dibujos con una linea negra sélida. Crea un
dibujo 100 % basado en vectores y lo pinta con la muestra de color de la linea vectorizada a
partir de la paleta de la escena.
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5. Siha seleccionado la opcidn Black and White (Blanco y negro), establezca los siguientes
parametros:

Parametro Descripcién

Determina qué valores de la imagen escaneada se

Threshold (Umbral) consideraran parte del dibujo, y qué se ignorara y eliminara
resho mbra

del dibujo vectorizado. Cuanto menor sea el valor, mas oscura

serd laimagen y viceversa.

Determina la suavidad de las lineas. Cuanto menor sea el
Smooth (Suavizar) valor, méas detalle se conservard. Cuanto mayor sea el valor,
mas pulidas y facil de editar seran las lineas.

6. Haga clic en OK (Aceptar).

Las imagenes vectorizadas apareceran en los destinos seleccionados.

NOTA

Sitiene imagenes de mapa de bits en la libreria, puede arrastrarlas y colocarlas directamente en la
escena como una manera rapida de importar una imagen de mapa de bits. Sin embargo, no tendra
acceso a todas las opciones de importacion.
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Capitulo 8: Colocacion y animacion de capas

La configuracidn de una escena se puede comparar con la construccion de la escenografia para un programa
de television. Este es el punto en el que coloca el elemento de escena, como el encuadre de camara, los
elementos de fondo y los personajes.

Colocacion de capas

El primer paso para configurar la escena es colocar cada capa en su posicion, angulo y tamafio iniciales. Puede
realizar cualquier tipo de transformacion geométrica en una capa con la herramienta .} Transform
(Transformar).

Paneo, rotacidn, escala o sesgo de una capa con la herramienta Transform
(Transformar)

1. En la barra de herramientas de herramientas, seleccione la herramienta i} Transform
(Transformar) o pulse Mayus + T.

2. Enla barra de herramientas de herramientas, si esta habilitado el modo Animate Current Frame
(Animar fotograma actual) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla),
haga clic en él para abrir el menl emergente Animate (Animar) y seleccione % Animate Off
(Animar desactivado).

3. Enla vista de propiedades de la herramienta, asegurese de que la opcidn & Peg Selection Mode
(Modo de seleccion de peg) esta deshabilitada.

4. En lavista de camara o de linea de tiempo, haga clic en la capa que desea manipular para
seleccionarla.

CONSEJOS

» Sidesea seleccionar varias capas en la vista de cdmara, mantenga pulsado Mayus y
haga clic en cada capa que desee seleccionar.

» Sidesea seleccionar varias capas en la vista de linea de tiempo, mantenga pulsado
Ctrl (Windows/Linux) o 8 (macOS) y haga clic en cada capa que desee seleccionar.

» Sidesea seleccionar una serie contigua de capas en la vista de linea de tiempo,
mantenga pulsado Mayus, haga clic en la primera capa que desea seleccionar y
luego en la ultima.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

[ Escalar verticalmente ] [ Sesgar horizontalmente ]

] |

T Escalar horizontal y verticalmente

—[ Sesgar verticalmente ]
U—[ Escalar horizontalmente ]
—[ Punto de pivote ]

D—[ Escalar horizontal y verticalmente ]

[ Escalar verticalmente [ Sesgar horizontalmente ]

Rotar

[ Escalar horizontal y verticalmente

[ Sesgar verticalmente

[ Escalar horizontalmente

1. Realice una de las siguientes acciones:

¢ Mover: mueva el cursor por la ilustracién. Cuando el cursor se convierta en +#, haga clicy
arrastrelo sobre la ilustracién para moverla.

» Rotar: coloque el puntero fuera de una esquina del cuadro de limite. Cuando el cursor se
conviertaen ¢, haga clic y arrastrelo para rotar.

ﬁ o

e Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del
manipulador. Cuando el cursor se convierta en ", haga clic y arrastre para escalar la capa.
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@ NOTA

Al realizar el escalado de la seleccidn, puede mantener pulsado Mayus para
mantener las proporciones entre el ancho y la altura.

e Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el
cursor se convierta en 1[ , haga clicy arrastre hacia arriba o hacia abajo para sesgar la capa
en vertical.

* Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el
cursor se convierta en =, haga clic y arrastre hacia la izquierda o hacia la derecha para
sesgar la capa en horizontal.

Cambio de posicion del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacion, escala, sesgo y volteo, se
realizan de forma relativa a la posicién del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta
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rotara alrededor de su punto de pivote, y al escalar la capa, se escalara como si su centro fuera realmente su
punto de pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el
pivote de la seleccién. Sin embargo, esto no tiene un efecto permanente. Solo cambiara temporalmente la
posicién del pivote para que le ayude a realizar transformaciones en el fotograma seleccionado, pero el punto
de pivote real de la capa de dibujo permanecera igual.

Puede cambiar de forma permanente la posicion del punto de pivote de una capa utilizando una de las
herramientas de la barra de herramientas de animacién avanzada.

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya esta animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de
acuerdo con la posicién del nuevo punto de pivote. Por lo tanto, la animacidn existente tendra una
apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que
siempre se asegure de que el punto de pivote se encuentre en la posicién idénea antes de
comenzar la animacion.

Cambio de posicion permanente del punto de pivote de una capa

1. En la barra de herramientas de animacién avanzada, seleccione la herramienta <¢> Translate
(Traslacidn), (¥ Rotate (Rotar), & Scale (Escalar) o /7 Skew (Sesgar).

2. Realice una de las siguientes acciones:

» En la vista de linea de tiempo, seleccione la capa a la que desee mover el pivote.

» En la vista de camara, utilice Ctrl + clic (Windows/Linux) o # + clic (macOS) en la capa para
la que desea mover el pivote.

El punto de pivote @ aparece en la vista de camara.

3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratén se convierta en 4—}; haga clicy
arrastrelo al punto de pivote para cambiar de posicion.
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El punto de pivote de la capa ha cambiado de posicidn. Si la capa se ha animado, su posicién se
desplazard por las escenas de forma relativa a la cantidad que acaba de desplazar el punto de
pivote.

Animacion de una capa

Puede animar una capa colocandola en diferentes posiciones, angulos y tamafios en distintos puntos a lo largo
de la linea de tiempo de la escena. Para ello, puede crear fotogramas clave de animacion en la capa. Un
fotograma clave registra las transformaciones geométricas en una capa en un punto especifico en el tiempo.
Cuando dos fotogramas clave de animacion se encuentren en una capa en diferentes puntos de la linea de
tiempo de la escena, Harmony interpolara automaticamente la posicidn, el angulo y el tamafio de la capa en
cada fotograma entre esos dos fotogramas clave, creando una animacion.

Colocar en el segundo
fotograma clave

Colocaren el
primer fotograma
clave

| Colocar para cada fotograma intercalado ]

Animacién de una capa

1. En la barra de herramientas de herramientas, seleccione la herramienta i} Transform
(Transformar) o pulse Mayus + T.

2. En la barra de herramientas de herramientas, si esté seleccionado el modo ¢ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menl emergente Animate (Animar) y seleccione < Animate Current Frame (Animar
fotograma actual).
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3. Sila capa tiene un peg padre:

» Sidesea animar en el peg en lugar de en la capa, asegurese de que el modo /& Peg
Selection (Seleccién de peg) esté habilitado en la vista de propiedades de la herramienta.

» Sidesea animar directamente en la capa, asegurese de que el modo & Peg Selection
(Seleccién de peg) esté deshabilitado en la vista de propiedades de la herramienta.

4. En la vista de linea de tiempo, vaya al primer fotograma.

5. En el menu superior, seleccione Animation (Animacion) y asegurese de que la opcién Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no estd marcada. De este modo, Harmony creard la
animacion automaticamente entre los fotogramas clave de la animacién que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.

7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

* En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

¢ Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

Fotograma clave

8. En la vista de camara, seleccione el elemento que desea animar y muévalo, rételo, escédlelo o
sésguelo de modo que esté en su posicion de inicio correcta.
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9. En la vista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicién.

ro=al

o

10. Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botén derecho en la
seleccidn y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en la lista de linea de tiempo, junto con una linea desde el
primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se
animara mediante Harmony.

[ I-.I [ [ |-.1|_'__|—.

[ Fotograma clave l

11. En lavista de cdmara, mueva, rote, escale o sesgue el elemento de modo que esté en su segunda
posicién correcta.

12. Enla vista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

13. En la barra de herramientas de reproduccidn, haga clic en el botédn » Play (Reproducir) para
obtener una vista previa de la animacion.

NOTA

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones
desde las vistas superior o lateral durante la reproduccidon. Sin embargo, la reproduccion esta
deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en el menu superior
seleccione Play > Enable Playback > Top View (Reproducir > Activar reproduccion > Vista
superior) o Side View (Vista lateral).
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Capitulo 9: Colocacion y animacion de la camara

En Harmony, puede animar objetos dibujandolos en su capa individual y colocandolos a continuacién en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear una ruta de
movimiento. Se puede aplicar el mismo principio a la cdmara de la escena, ya que se trata de una capa.
Adicidon de una camara

De forma predeterminada, una escena no tiene capa de cdmara. Para poder ajustar el angulo de la cdmaravy la

posicién de la escena, debe agregar una a su escena.

Adicion de una camara

1. Realice una de las siguientes acciones:

* En la vista de linea de tiempo, haga clic en el botén +, Add Layer (Agregar capa) del
menu emergente y seleccione Camera (Camara).

* En el mend superior, seleccione Insert > Camera (Insertar > Camara).

Se agrega a la escena una nueva capa de cdmara y aparece en la vista de linea de tiempo.

ro=al
o

o

Aunqgue es posible tener varias cdmaras en la misma escena, solo puede ver su escena utilizando las cdmaras
de una en una. Esto puede resultar util si aun esta trabajando en la composicidn de escena y tiene distintas
configuraciones de camara para probar.

Cambio entre camaras

1. En el mend superior, seleccione Scene > Camera (Escena > Camara).

2. Entre las cdmaras de la lista, seleccione la cdmara con la que desea trabajar.

Adicion de un peg padre

Aunque es posible colocar una cdmara sin necesidad de usar un rigging debajo de un peg, se recomienda
hacerlo siempre por dos motivos:

» Permite colocar, rotar y alejar o acercar la cdmara con la herramienta Transform (Transformar).

* Permite animar los movimientos de la cdmara. Sin un peg padre, la posicidn, el angulo y el zoom de la
cadmara son estdticos.
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Adicion de un peg padre a una camara

1. En la vista de linea de tiempo, seleccione la capa de camara.

2. Enlabarra de herramientas de capas, haga clic en el botdn (% Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de camara y se conecta a ella
automaticamente.

Colocacidon de la camara

La accidon de la escena tiene lugar dentro del encuadre de cdmara, de modo que es muy importante
configurarlo correctamente. Puede ajustar la resolucion de la cdmara y otros pardmetros relacionados en la
ventana Scene Settings (Configuracidn de escena), a la que se puede acceder desde el menu principal de
Scene (Escena).

Para cambiar la posicidn de la cdmara directamente, puede moverla con la herramienta .} Transform
(Transformar) o *I* Translate (Traslacidn), puede rotarla con la herramienta (=¥ Rotate (Rotar) y puede alejarla
o acercarla con la herramienta (7] Scale (Escalar) de la barra de herramientas de animacidén avanzada.
También puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha usado un rig
de camara debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta Transform
(Transformar). Los siguientes pasos indican cémo manipular la cdmara al usar un rig debajo de un peg.

Colocaciéon de una camara en la que se ha usado un rig debajo de un peg en la vista de
camara

1. Realice una de las siguientes acciones para seleccionar el peg padre de la camara.

* En la vista de linea de tiempo, haga clic en la capa del peg padre de la camara.

* En la vista de cdmara, haga clic en el encuadre de la cdmara. El encuadre de la cdmara es un
rectangulo fino alrededor de la etapa de la escena.

Aparece un cuadro de control alrededor del encuadre de la camara.
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i

Acercar o 0 o Acercar o
alejar alejar

Mover

Mover

0 [

Mover

Acercar o Acercar o

alejar = = alejar

2. Realice una de las siguientes acciones:

i

* Mover el encuadre de la camara: coloque el cursor sobre cualquiera de sus bordes o sobre
el centro. Cuando el cursor cambie a +}+, haga clic y arrdstrelo en el encuadre de la cdmara
para cambiarlo de posicidn.

» Acercar o alejar: coloque el cursor en una de las esquinas del encuadre de la camara.
Cuando el cursor cambie a ™, haga clic y arrastrelo a la esquina para cambiar el tamafio del
encuadre de la cdmara. Al contraer el encuadre de la camara se acercara la escena, y al
expandirlo, se alejara.
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» Rotar la cdmara: coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a
o, haga clic y arrastrelo para rotar el encuadre de la cdmara.

Animacion de la camara

La camara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de
linea de tiempo y puede utilizar las mismas herramientas y modos de seleccidén para compensarla o animarla.
Sin embargo, la capa de la cdmara en si es estatica, lo que significa que mantiene la misma posicién y angulo
en toda la escena. Para poder animar la cdmara, es necesario conectarla a una capa de peg, que se puede
animar, y que afectara directamente a la posicion y al angulo de la camara.

Puede animar los movimientos de la cdmara directamente en la vista de cdmara.

81



Capitulo 9: Colocacién y animacién de la camara

Animacion de la camara

1. Enla barra de herramientas de herramientas, si esté seleccionado el modo ¢ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menl emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

2. En la barra de herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar) o pulse Mayus + T.

3. Enellado derecho de la vista de linea de tiempo, en la capa de peg de camara, seleccione el
fotograma en el que desee que comience el movimiento de camara.

4. Realice una de las siguientes acciones para agregar un fotograma clave:

* En la barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botdén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicién de cdmara que este fotograma clave.

5. En la vista de cdmara, manipule la cdmara para que esté en la posicidn correcta cuando la camara
comience a moverse.
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6. En la vista de linea de tiempo, haga clic en la celda en la que terminara el movimiento de camara.

7. Realice una de las siguientes acciones:

* En la barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Aparece un fotograma clave en dicha celda.

8. En la vista de camara, manipule la camara para que esté en la posicidn correcta cuando la cdmara
termine de moverse.

9. En la vista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.
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10. En la barra de herramientas de reproduccidn, haga clic en el botdn » Play (Reproducir) para
obtener una vista previa de la animacion.
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Capitulo 10: Creacion de un rig de un personaje cut-out

En Harmony, un rig de personaje es bdsicamente una plantilla basada en el modelo del personaje, pero en la
cual todas las partes mdviles estan divididas en distintas capas y ordenadas en una jerarquia que facilita la
animacidn digital, también conocida como animacidn cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
que partir. Si tiene un dibujo de un personaje disponible, impdrtelo en una nueva escenay, a continuacion,
ajuste la escala y coldquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con éL.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccion, aprendera uno de los
métodos mas comunes y sencillos. Para la primera descomposicidn de personaje, siga estas instrucciones para
hacerse una idea de cdmo funciona Harmony. Una vez que conozca las funciones y comandos basicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccion.

- ““’%AQ 00.\\
ﬁUm\ (

Dibujo de las piezas

La técnica de descomposicion principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. En lavista de linea de tiempo, agregue una nueva capa de dibujo para cada parte del cuerpo que
desee separar. Puede pulsar Ctrl + R (Windows/Linux) o ¥ + R (macOS) para agregar nuevas
capas de dibujo.
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+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
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En la vista de linea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la
parte.

En la barra de herramientas de herramientas, seleccione la herramienta de dibujo que desee.
Existen dos métodos que se suelen utilizar para dibujar las partes de un modelo de personaje cut-
out:

« Utilizar la herramienta # Pencil (Lépiz) y suavizar las lineas con la herramienta R
Smooth Editor (Editor suave).

* Utilizar la herramienta G Polyline (Polilinea). Este método permite dibujar con gran
precisidn, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor nimero de puntos posible, para
gue sean faciles de manipular, modificar o volver a dibujar.

En la vista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Como pintar en la pagina 49.

Si prefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demds capas con colores descoloridos:

* En la barra de herramientas de la vista de dibujo, haga clic en el botén U Light Table
(Mesa de luz).

e Pulse Mayus + L.

En la vista de cdmara o de dibujo, dibuje la nueva parte.
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7. Sidesea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta (~ Stroke (Linea vectorial transparente).

NOTA

De forma predeterminada, las lineas vectoriales transparentes creadas con la
herramienta Stroke (Linea vectorial transparente) no son visibles. Para ver las lineas
vectoriales transparentes en el dibujo, seleccione View > Show > Show Strokes (Ver >
Mostrar > Mostrar lineas vectoriales transparentes) en el menu superior o pulse K.

8. En la barra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
® Paint Unpainted (Pintar drea no pintada) para colorear el dibujo.

9. En la vista de color, cree el color de relleno deseado si no se encuentra todavia en la paletay, a
continuacion, seleccidnelo.

10. En la vista de cdmara o de dibujo, pinte el dibujo.
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11.

12.

En la barra de herramientas de herramientas, seleccione la herramienta X Select (Seleccionar).
Seleccione el dibujo y acople las lineas haciendo clic en el botén X Flatten (Acoplar) de la vista de
propiedades de la herramienta.

Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.

+
+
+
+
+
+
+
+
+
+
+
+
+
+
+
+
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+
+
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+
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Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para compensary
transformar dibujos que estén debajo de su jerarquia, sin transformar directamente los dibujos.

Al crear un rigging o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo.
De este modo, se permite mantener los fotogramas clave y los dibujos de animacidn en capas separadas, lo
que facilita el trabajo sobre la posicidn y exposicion de las capas de dibujo por separado en la vista de linea de
tiempo. También facilita la creacidn de una jerarquia de las partes del cuerpo que se pueden animar juntas y
por separado.

Contiene las animaciones de posicidn, rotacion y
escala del elemento.

e S VAR A

1

Contiene los dibujos reales, los fotogramas en los que se exponeny
cuéntos fotog SEe expanen.

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccion de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas
de dibujo de animacion para que solo se puedan animar los pegs.

NOTA
También es posible hacer que una capa de dibujo sea padre de otra capa de dibujo. Aligual que la

forma de animacion de un peg anima sus capas hijas, la animacién de una capa de dibujo con hijos
también animard sus capas hijas. Ambas capas seguiran apareciendo en la animacion.

Cdémo emparentar pegs a las capas en la vista de linea de tiempo

1. En la vista de linea de tiempo, seleccione todas las capas.

+
|

¥

+
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2. Enla barra de herramientas de capa de linea de tiempo, haga clic en el botén (% Add Peg (Agregar
peg) para agregar un peg padre a todas las capas seleccionadas.

89



Capitulo 10: Creacién de un rig de un personaje cut-out

Creacion de una jerarquia de capas

+ [ )

Harmony permite crear el rig en una jerarquia elaborada, lo que permite a su vez establecer qué partes del rig

deben influir en otros miembros y cdmo pueden moverse de forma independiente. Por ejemplo, al crear un

rigging del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo,

y que la capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el

antebrazo, la mano también lo hard, y si mueve el brazo, el antebrazo y la mano también lo haran.

Jerarquia de brazo
derecho feje

Jerarquia de pierna
derecha

Jerarquia de cabeza

Jerarquia de brazo
izquierdo

Jerarquia de pierna

= izquierda

Al crear un rig de personaje basico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede
crear una jerarquia que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de
las piernas a las caderas. Esto crearia una jerarquia como esta:
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Creacidn de una jerarquia en la vista de linea de tiempo

1. Enel dreaizquierda de la vista de linea de tiempo, seleccione la capa que desee que sea la capa
hija.

2. Arrastre el hijo y coldquelo sobre la capa que desee que sea la capa padre. Asegurese de no
colocar la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que manipule todas las partes del personaje,
con un peg maestro en la raiz. Al crear un rig, si desea que varias capas tengan un padre comun,
pero ninguna de las partes existentes del rigging puede servir como dicho padre, cree un nuevo peg
y anide esas capas debajo de dicho peg.

+
+
+
+
+
e
+
+

NOTA

En la vista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
presionada la tecla Mayus, arrastrando la capa padre lejos de la capa hija y colocandola en

cualquier lugar de la lista.
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Al crear un rigging, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en
que se representan. Las capas de la parte superior de la lista se representaran sobre las capas de la parte
inferior de la lista. Si tiene que cambiar el orden de una capa durante la animacidén, puede realizar un
desplazamiento pequeno de la posicion de esta capa sobre el eje Z para anular el orden de la capa y forzarla a
aparecer debajo o sobre otras capas.

Desplazamiento pequeio de una capa sobre el eje Z

1. En la barra de herramientas de herramientas, seleccione la herramienta .} Transform
(Transformar).

2. Enlavista de linea de tiempo, de nodos o de camara, seleccione la capa que desea desplazar.

3. Siha seleccionado la capa en la vista de linea de tiempo o de nodos, haga clic en la pestafia de la
vista de cdmara para establecer el enfoque en esta vista.

4. Realice una de las siguientes acciones:

e Para realizar un desplazamiento pequenio de la capa hacia delante, pulse Alt + flecha
abajo.

» Para realizar un desplazamiento pequefio de la capa hacia atras, pulse Alt + flecha
arriba.

Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. El peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
util para colocar y escalar el personaje en relacion a la escena, asi como para animar la trayectoria del
personaje cuando tiene que moverse entre las areas de la escena.
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Adicién de un peg maestro en la vista de linea de tiempo

1.

2.

En la vista de linea de tiempo, seleccione la capa superior.

En la vista de linea de tiempo, haga clic en el botén (% Add Peg (Agregar peg).

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
Asigne el nombre Master mas el nombre del personaje al nuevo peg.

En la vista de linea de tiempo, seleccione todas las capas que desee conectar al nuevo peg.
Recuerde que la capa superior ya es un hijo del peg, asi que no lo incluya en la seleccion.

Arrastre la seleccién SOBRE la capa del peg para emparentar todas las piezas del personaje al
peg. Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres
de nuevo a la parte superior de la pila de capas.

+
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Capitulo 11: Animacion de un personaje cut-out

Harmony ofrece herramientas muy utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacidn con objeto de permitir
combinar los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creacion de una animacion cut-out simple

Crearemos una animacion cut-out simple realizando la primera pose del personaje en el primer
fotograma, la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. En la vista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:
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» Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicidn).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el numero de fotogramas
de la escena y confirme. De este modo, el modelo quedara expuesto (serd visible) en toda la
escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

* En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. En la barra de herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar) o pulse Mayus + T.

7. Enla barra de herramientas de herramientas, si esta seleccionado el modo § Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menud emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

8. En la vista de camara, seleccione las partes que desea animar. El cuadro de control de la
herramienta Transform (Transformar) aparecerd alrededor de la capa seleccionada. Cada parte del
cuadro de control de la herramienta Transform (Transformar) se puede usar para realizar distintos
tipos de transformaciones:
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9. Utilice la herramienta

10.
11.

12.

13.

seleccion a su nueva posicion.

! Transform (Transformar) para rotar, sesgar, escalar o trasladar la

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.

En la barra de herramientas de herramientas, active la funcién é Onion Skin (Papel cebolla).

En la vista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén & Add Keyframe

(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

Pulse F6.
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El segundo fotograma clave aparece, junto con una linea desde el primer fotograma clave al
segundo fotograma clave. Esto indica que cada fotograma intercalado se interpolara mediante
Harmony.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un
fotograma clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

» Haga clic con el botén derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

» Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o # + K (macQOS)

Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de
forma predeterminada, seleccione Animation (Animacién) en el menu superior y asegurese de que
la opcidn Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Los fotogramas entre dos fotogramas clave estan interpolados
por Harmony si el primero de los dos fotogramas clave es un fotograma clave de
movimiento.

14. En la vista de camara, cambie de nuevo la pose del personaje.

Capm
seleccionady

15. Repita este proceso para todas las poses que desee agregar a la animacion.
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Ajuste de la velocidad de la animacion

1. En la vista de linea de tiempo, contraiga la jerarquia del rig (o de la parte del rig) a la que desea
aplicar una velocidad.

NOTA

Cuando se aplica una velocidad a una capa con hijos y se contrae la jerarquia de esta
capa, la velocidad se aplica a esa capa y a todos sus hijos.

2. Seleccione uno de los fotogramas clave de la animacion.

NOTA

Solo debe seleccionar un fotograma clave. El cuadro de didlogo Set Ease for Multiple

Parameters (Definir aceleracidon para varios parametros) solo puede editar la
aceleracion en un fotograma clave a la vez, pero también le permite saltar rapidamente
entre fotogramas clave en la linea de tiempo.

3. Realice una de las siguientes acciones:

» En la vista de linea de tiempo, haga clic con el botén derecho y seleccione Set Ease
For Multiple Parameters (Definir aceleracién para varios parametros).

* En la barra de herramientas de linea de tiempo, haga clic en el botédn =~ Set Ease For
Multiple Parameters (Definir aceleracion para varios parametros).
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Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracidn para varios

parametros).
]
Editor de =
Bézier | =
]

4. En el editor de Bézier, haga clic y arrastre el controlador Bézier para ajustar la velocidad de los
fotogramas clave seleccionados.

Controladores

5. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de
tiempo) y Value Ratio (Ratio de valor) debajo del editor de Bézier. Los valores se calculan como un
porcentaje.

* En los campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que desea que
dure la velocidad. Las curvas Bézier se alejaran horizontalmente de su fotograma clave. El
valor debe estar entre el 0 % y el 100 %.

e En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de
valor derecho), escriba el valor como porcentaje correspondiente a la cantidad de sesgo que
desea que tenga la velocidad. La curva Bézier se movera verticalmente hacia el fotograma
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clave mas cercano si el valor es positivo o lejos del fotograma clave mas cercano si su valor
es negativo. El valor debe estar entre el 0 % y el 100 %.

Para aplicar estos parametros de velocidad Unicamente a un tipo de funcién determinado, como

Rotation (Rotacion) o Scale (Escala), en la seccidn Filters (Filtros), anule la seleccidon de los tipos de

funcidn a los que no desee que se apliquen.

Motion (Movimiento): aplica los parametros de velocidad a las funciones Position X
(Posicidn X), Position Y (Posicion Y), Position Z (Posicidn Z) y 3D Path (Ruta 3D)
seleccionadas.

Rotation (Rotacidn): aplica los parametros de velocidad a las funciones de angulo
seleccionadas.

Scale (Escala): aplica los parametros de velocidad a las funciones de escala
seleccionadas.

Skew (Sesgar): aplica los parametros de velocidad a las funciones de inclinacién
seleccionadas.

Morphing: aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que Morphing solo esta disponible
en Harmony Advanced y Harmony Premium.

Other (Otras): aplica los parametros de velocidad a todas las demds funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

Haga clic en uno de los siguientes botones:

Apply/Previous (Aplicar/anterior): aplica los parametros de velocidad al fotograma
clave seleccionado y, a continuacion, salta al fotograma clave anterior de la linea de
tiempo para que después pueda ajustar su velocidad.

Apply (Aplicar): aplica los parametros de velocidad al fotograma clave seleccionado.

Apply/Next (Aplicar/siguiente): aplica los parametros de velocidad al fotograma
clave seleccionado y, a continuacion, salta el siguiente fotograma clave de la linea de
tiempo para que después pueda ajustar su velocidad.

Close (Cerrar): cierra el cuadro de dialogo. Si no ha aplicado las modificaciones, se
cancelaran

Desplazamiento por las capas

Dado que la animacidn cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los
atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccién), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea
de tiempo. Por lo tanto, puede usar la vista de camara para seleccionar de forma visual la capa con la que
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desee trabajar vy, a continuacion, usar el atajo de Centre on Selection (Centrar en seleccidon) para encontrar la
capa en la vista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccidn actual en la vista de linea de tiempo

1. En la vista de linea de tiempo, contraiga todas las capas.

2. En la barra de herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar).

3. Enla vista de cdmara, seleccione una capa.
4. Realice una de las siguientes acciones:

» Haga clic en la pestafia de la vista de linea de tiempo para ajustar el centrado en la
misma vy, a continuacion, pulse O.

e En la barra de herramientas de la vista de linea de tiempo, haga clic en el botdn
Centre on Selection (Centrar en seleccién).

La vista de linea de tiempo esta ahora centrada en la capa seleccionada y todos sus padres se han

expandido automaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer tedioso tener que hacer clic en la pestaiia de
vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse Enter
(Centrarse en ratdn). Ajustard el centrado en una vista en cuanto el cursor del ratén entre en ella y hara
funcionales al instante todos los atajos de teclado de esta vista.

Activacion de la preferencia Focus On Mouse Enter (Centrarse en raton)

1. Enel menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows) o Harmony
> Preferences (Harmony > Preferencias) (macOS).

2. Abra la pestana General.

3. Enla seccién Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse

en raton).
4. Haga clic en OK (Aceptar).

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratdn entre en la
vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rapidamente la seleccidn de la capa
seleccionada actualmente a su padre o hijo, permitiendo asi el desplazamiento con rapidez por la jerarguia del

personaje.
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Seleccion del padre o del hijo de la capa seleccionada

1. En la barra de herramientas de herramientas, seleccione la herramienta .} Transform
(Transformar).

2. Enlavista de propiedades de la herramienta Transform (Transformar), asegurese de que esté
desactivado el modo /x Peg Selection (Seleccidn de peg).

3. Enlavista de camara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

4. Realice una de las siguientes acciones:

» Seleccione Animation > Select Parent (Animacidn > Seleccionar padre) o pulse B para
seleccionar la capa padre.

» Seleccione Animation > Select Child (Animacidn > Seleccionar hijo) o pulse Mayus + B para
seleccionar la capa hija.
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NOTA

Al subir o bajar la jerarquia de nodos, estos atajos de teclado omiten cualquier nodo de efecto
de la jerarquia y solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se
optimizan para la animacion cut-out. En el cuadro de didlogo Keyboard Shortcuts (Atajos de
teclado), en la seccidén General, estos atajos de teclado se denominan Select Parent Skipping
Effects (Seleccionar efectos de omisidon del padre) y Select Child Skipping Effects
(Seleccionar efectos de omisidn del hijo). Si desea utilizar los atajos de teclado para navegar
por la jerarquia sin omitir los nodos de efectos, puede asignar atajos de teclado
personalizados para los comandos Select Parent (Seleccionar padre) y Select Child
(Seleccionar hijo).
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Capitulo 12: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Las deformaciones funcionan mediante la creacién de puntos de control en un
dibujo. Al mover dichos puntos, el dibujo se dobla o distorsiona de modo que las partes del dibujo que estan
vinculadas a un punto de control siguen dicho punto al lugar donde lo posicione.

Los deformadores pueden aumentar considerablemente el rango de movimientos y animaciones que el rig de
un personaje cut-out sea capaz de realizar sin necesidad de dibujar nuevas poses o recurrir a la animacién
fotograma a fotograma. Un personaje cut-out en rig con deformaciones se puede animar de una forma que se
asemeje a la fluidez y flexibilidad de la animacidn tradicional. Ademas, los deformadores se pueden utilizar
para modificar, mejorar o facilitar la animacion fotograma a fotograma cuando sea necesario.

Los deformadores funcionan al crear un rigging con ellos en la parte del cuerpo que desee deformar, crear una
estructura de deformacion y, a continuacién, animarlo. Se puede realizar facilmente con la herramienta {T

Rigging.
Hay dos tipos de deformadores disponibles en Harmony Essentials:
¢ Hueso

¢ Hueso parajuego

Deformador de huesos

La deformacion de hueso permite crear una estructura similar al hueso en la que cada parte es sdlida, pero las
articulaciones son flexibles. Esto es sobre todo util para la animacién de los miembros de un personaje, como
los brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos.

Por ejemplo, se puede utilizar una deformacion de hueso para articular un brazo que estd hecho de un solo
dibujo, de modo que el brazo y el antebrazo se puedan mover de forma independiente, sin necesidad de
dibujar la parte superior del brazo y el antebrazo en capas diferentes. Harmony deformara el dibujo para que
parezca que estd articulado. Las distintas partes de una deformacidn de hueso se pueden rotar alrededor de su
articulacion, extenderse y acortarse, proporcionandole las mismas capacidades que las articulaciones de
animacién en distintas capas, sin tener que preocuparse por la separacidn de piezas, puntos de pivote o recorte
de contornos.
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Punto de desplazamiento

Radio de articulacidn )
.;od—/

Articulacién

Deformador de hueso para juego

La deformacién de hueso para juego es parecida a la deformacion de hueso. Le permite crear estructuras
compuestas de puntos, que representan las articulaciones, y segmentos de lineas rectas vinculando dichos
puntos que representan los huesos. La deformacion de hueso para juego es diferente, ya que se optimiza para
motores de juego como Unity. Por lo tanto, generalmente solo se usa para personajes animados destinados a
importarse en juegos de Unity y no para producciones de animacion.

A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una propiedad
de sesgo. Los pliegues de la articulacidon también parecen ligeramente mas redondos.

Punto de desplazamiento

Radio de articulacicn - /

Articulacién

Creacion de deformadores

La manera mas sencilla de crear deformadores es usar la herramienta {T Rigging, disponible en la barra de
herramientas de deformacion. Con esta herramienta, todo lo que necesita hacer para crear un deformador es

105



Capitulo 12: Uso de deformadores

seleccionar la capa que desee deformar y, a continuacién, colocar cada punto del deformador en la vista de
camara.

Los deformadores existen en la escena como una jerarquia de capas de deformacion. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la
jerarquia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacion del
hombro, el segundo punto debe ser el codo y el tercero, la muifeca.

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta Rigging, se crea automaticamente como padre de la capa seleccionada, y afectard a
la capa seleccionada y a todos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de
intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazo y el brazo se divide en varias capas, se puede crear
un rig del brazo en una jerarquia donde el brazo superior sea la raiz, el antebrazo sea el hijo del brazo superior
y la mano sea el hijo del antebrazo. A continuacidn, si crea su deformador en la parte superior del brazo, se
creara como padre de la parte superior del brazo y, por lo tanto, afectara a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los
hijos de este peg. Esto se debe a que es probable que un peg sea mas util sobre un deformador que debajo de
él. Si mueve las capas que estan debajo de un deformador, saldran de la zona de deformacidn prevista y
pueden aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones
posibles debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el
deformador se queda intacto. Dado que el deformador se creard como padre de todos los hijos del peg,
afectard a todas las capas que haya debajo de este.

Creacidon de un deformador de hueso

1. Una vez seleccionado el elemento, seleccione la herramienta {T Rigging en la barra de
herramientas de deformacion.

2. Enla vista de propiedades de la herramienta, habilite el modo 4 Bone (Hueso).
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3. Hagaclicen el lugar donde desee crear la articulacion de raiz de la estructura dsea. La articulacién
de raiz deberia ser la que esté vinculada al resto del cuerpo. Por ejemplo, en un brazo, la
articulacion de raiz seria el hombro.

4. Haga clic en el lugar donde desee crear la segunda articulacion.

Se creara un hueso entre la primera y la segunda articulacion.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacidn, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacién. Cada punto de un deformador de hueso, a excepcién del primero y del Ultimo, cuenta
con un radio.

6. Haga clic y mantenga pulsado el punto de control del radio de la articulacidon anterior y ajuste el
radio de la articulacién de modo que cubra la articulacién correctamente.

7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Asegurese de crear cada
articulacion en el orden correcto desde la raiz hasta la extremidad.
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Visualizacion de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de camara independientemente de la
seleccidn actual. Al crear una cadena de deformacidn, sus controles de deformacién se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacidn no se mostraran automaticamente. Asimismo, al desactivar una
cadena de deformacidn no se ocultaran sus controles de deformacion.

Para poder animar o modificar una cadena de deformacidn existente, debe mostrarla de forma manual.

Visualizacion de los controles de deformacion

1. Realice una de las siguientes acciones:

* En la vista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas
a la cadena de deformacion que desee visualizacién.

» En la vista de linea de tiempo, seleccione cualquier parte de la cadena de deformacion que
desee visualizacion.

2. En la barra de herramientas de deformacion:

» Haga clic en el botédn Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacidn seleccionada y ocultar el resto) © para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que
se muestre.

» Haga clic en el botén Show Selected Deformers (Mostrar deformadores seleccionados) 2
para mostrar la cadena de deformacion del elemento seleccionado junto a cualquier otra
cadena de deformacion que se muestre.

Los controles de deformacién aparecen en la vista de camara.

NOTA

El botén Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacidn seleccionada y ocultar el resto) mostrara todas las cadenas de deformacion que
se encuentran en la jerarquia de la seleccidn. Por ejemplo, si esta seleccionado el peg maestro
de un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si
estan seleccionadas varias capas vinculadas con distintas cadenas de deformacion, se
mostraran todas sus cadenas de deformacidn.

Cdmo ocultar los controles de deformacion

1. Realice una de las siguientes acciones:
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» Haga clic en el espacio negativo de la vista de cdmara, de linea de tiempo o de nodos
para descartar la seleccidn actual y, a continuacidn, haga clic en el botdn ©~ Show the
Selected Deformation Chain and Hide All Others (Mostrar la cadena de deformacion
seleccionada y ocultar el resto) de la barra de herramientas de deformacion.

» Seleccione una capa que no esté vinculada a ningtin deformador y, a continuacion,
haga clic en el botén © Show the Selected Deformation Chain and Hide ALl Others
(Mostrar la cadena de deformacion seleccionada y ocultar el resto) de la barra de
herramientas de deformacion.

* En la barra de herramientas de cdmara, haga clic en el botdn @ Hide All Controls
(Ocultar todos los controles).

* En el mend superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

e Pulse Mayus + C.

Animacion con deformadores

Aligual que con los pegs de animacién y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacién de deformadores
funciona exactamente igual que la realizacién de modificaciones en un deformador, excepto que requiere el
uso de la herramienta {1 Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la
herramienta Transform (Transformar), los controles de deformacidn de la vista de cdmara se muestran en
color verde, lo que significa que se encuentran en modo de animacidn, mientras que cuando se selecciona la
herramienta Rigging, se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacion de deformaciones de hueso y hueso para juego

1. En la vista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse

(Expandir/Contraer).
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3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:

» Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas
de la escena y confirme. De este modo, el modelo quedara expuesto (serd visible) en toda la
escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se vera afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

* En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. En la barra de herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar) o pulse Mayus + T.

7. Enla barra de herramientas de herramientas, si estd seleccionado el modo § Animate Off (Animar
desactivado) o g‘% Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menl emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

8. Realice una de las siguientes acciones:

» En la vista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas
a la cadena de deformacidn que desee animar.

» En la vista de linea de tiempo, seleccione cualquier parte de la cadena de deformacion que
desee animar.
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9. En la barra de herramientas de deformacion:

» Haga clic en el botdn Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacidn seleccionada y ocultar el resto) ©~ para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que
se muestre.

» Haga clic en el botdn Show Selected Deformers (Mostrar deformadores seleccionados) 2
para mostrar la cadena de deformacién del elemento seleccionado junto a cualquier otra
cadena de deformacidn que se muestre.

Los controles de deformacion aparecen en la vista de camara.
10. En la vista de camara, realice lo siguiente:

» Para rotar el miembro entero, haga clic y arrastre el primer hueso. Esto girard el
primer hueso y todos los huesos subsiguientes.

e Para doblar el miembro, haga clic y arrastre otro hueso. Esto girara el hueso y todos
los huesos subsiguientes, pero dejara los huesos anteriores en su posicién actual.

e Para cambiar una articulacién de posicidn, haga clic y arrastre su punto de control.
Esto se puede utilizar para rotar, reducir o extender el hueso, y desplazara todos los
huesos subsiguientes.
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e Para reducir o extender un hueso sin rotarlo, mantenga pulsada la tecla Alty, a

continuacidn, haga clic y arrastre su punto de control.

» Para desplazar el miembro entero, haga clic y arrastre su punto de raiz.

4 \

También puede realizar un desplazamiento pequefio de una articulacion
en cualquier direccidn seleccionandola y, a continuacion, pulsando las

Q_ CONSEJO

teclas de flecha.

11. En lavista de linea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.

12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:
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* En la barra de herramientas de linea de tiempo, haga clic en el botén * Add
Keyframe (Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma
clave).

e Pulse F6.
13. Transforme el punto del deformador para crear su nueva pose clave.

14. Repita los pasos anteriores hasta que la animacién haya terminado.
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Capitulo 13: Importacion de sonido y sincronizacion de labios
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Importaciéon de sonido

Si desea agregar sonido a la animacion, es recomendable que edite y mezcle los archivos de sonido en un
software de edicidn de sonido. Al tener pistas de sonido de larga duracién mezcladas previamente, se
garantiza que el sonido conserve su tiempo, mezcla y calidad si utiliza software de terceros para la
postproduccion. Otra buena practica es mantener la pista de sonido separada en pistas de musica, efectos de
sonido y personajes para facilitar la sincronizacidn de la animacidn con voces y sonidos. De lo contrario, es
posible recortar los efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como
escenas de Harmony independientes. La pista de sonido del storyboard se cortara por escena y cada pieza se
insertara en las escenas exportadas, lo que permite ahorrar tiempo en la division e importacion de la pista de
sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

La importacién de una pista de sonido mas larga que la escena no ampliard la longitud de esta
ultima. La reproduccién de sonido se detendra al final de la duracidn de la escena.

Importacion de un archivo de sonido

1. Realice una de las siguientes acciones:
* En el mend superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

» En la vista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

Se abre el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido).

2. En el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.

El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido
de la pista de sonido.

114



Guia de introduccién de Harmony 24 Essentials

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de manera predeterminada. Si lo desea, puede visualizar la forma de
onda de una columna de sonido haciendo clic con el botén derecho en ella y seleccionando Sound
Display > Waveform (Visualizacion de sonido > Forma de onda).

Deteccidon automatica de sincronizacidon de labios

La adicién de la sincronizacidn de labios a la animacidn es fundamental para que parezca que los personajes
estan vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacion.

— e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automatica de sincronizacion
de labios. Esta funcion analiza el contenido de una pista de sonido de la escena y asocia cada fonema que
detecta con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estandar
de la industria de la animacion.

4/ /\ - /i 5 ?/ N
~ \

A B C D
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Boca adicional
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NOTA

Las letras asignadas a estas formas de boca son identificadores estandar y NO se corresponden
con el sonido que se pretende producir.

Esta es una aproximacion de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e A:m,b,p,h
e B:s,d,j ikt
e Ce,a
e D:AE
e E:0
e F:u,00
e G:f,ph
¢ X:silencio, sonido indeterminado

Al realizar la deteccién automatica de sincronizacion de labios, Harmony no crea dibujos de boca. Simplemente
rellena la columna de dibujo de la capa de la boca del personaje con la sincronizacién de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que
la deteccion automatica de sincronizacidn de labios funcione, la capa de la boca del personaje ya debe
contener un dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de
su letra correspondiente.

Generacion de una deteccion de sonido para sincronizacion de labios mediante la vista
de propiedades de capa

1. En lavista de linea de tiempo o de carta de rodaje, seleccione la capa de sonido.
Las opciones para dicha capa apareceran en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).
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Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizaciéon de labios a
cada celda de sonido.

3. Hagaclic en el botdn Map (Asignar) para abrir el cuadro de didlogo Lip-Sync Mapping (Asignacion
de sincronizacién de labios).

4. En el menu Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de
la boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacién de labios
utilizando dibujos situados directamente en la capa, o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ningtin simbolo) si desea utilizar los dibujos o el simbolo deseado del
menu desplegable.

5. En la seccion Mapping (Asignacidn), escriba el nombre del dibujo o los fotogramas del simbolo en
el campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de
las letras del fonema, puede saltarse este paso.

6. Haga clic en OK (Aceptar).
7. Enla barra de herramientas de reproduccién, habilite la opcidon ®) Enable Sound (Habilitar sonido).

8. Pulse el botén » Play (Reproducir) en la barra de herramientas de reproduccion para ver y oir los
resultados en la vista de camara.

Si tiene que realizar ajustes a la sincronizacién de labios generada automaticamente, consulte
Animacion manual de sincronizacidn de labios en la pagina 118.

Animacion manual de sincronizacidon de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca
debe exponerse en cada fotograma del cuadro del didlogo de su personaje. Para este proceso, utilizard la
funcidn Sound Scrubbing (Depuracién de sonido), que reproduce la parte de la pista de sonido en el fotograma
actual cada vez que mueva el cursor de la linea de tiempo, lo que permite identificar los fonemas que debe
hacer coincidir con la boca de su personaje. También se utilizara un dibujo de sustitucién para cambiar el dibujo
de la boca que se expone en cada fotograma.

Animacion de sincronizacion de labios utilizando la vista de linea de tiempo

1. Enla barra de herramientas de reproduccion, active el botén S Sound Scrubbing (Depuracién de
sonido).

2. En lavista de linea de tiempo, arrastre el cabezal de reproduccion rojo a lo largo de la forma de
onda de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

4. En la seccién Parameters (Parametros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al
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puntero de intercambio ‘{5

5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. EL
dibujo actual se cambia automaticamente a la nueva seleccion.
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Animacidn de sincronizacion de labios utilizando la vista de libreria

1. En la barra de herramientas de reproduccion, active el botén €S Sound Scrubbing (Depuracién de
sonido).

2. En lavista de linea de tiempo, arrastre el cabezal de reproduccion rojo a lo largo de la forma de
onda de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

4. En la ventana Drawing Substitution (Sustitucién de dibujo) de la vista de libreria, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de vista previa.
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Intercambio de dibujos utilizando la vista de sustituciones de dibujo

1.

4.

Agregue la vista de sustituciones de dibujo a su zona de trabajo realizando una de las siguientes
acciones:

» En la esquina superior derecha de las vistas existentes, haga clic en el botén #= Add View
(Agregar vista) y seleccione Drawing Substitutions (Sustituciones de dibujo).

* En el mend superior, seleccione Windows > Drawing Substitutions (Ventanas
> Sustituciones de dibujo).

En la barra de herramientas de reproduccion, active el botén €S Sound Scrubbing (Depuracién de
sonido).

En la vista de linea de tiempo, arrastre el cabezal de reproduccidn rojo a lo largo de la forma de
onda de la capa de sonido.

Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

En la vista de sustituciones de dibujo, haga clic en la pose de la boca que desee exponer en el
fotograma actual.

Library = Drawing Substitutions = | %

CONSEJO

También puede pulsar [ para sustituir el dibujo seleccionado por el dibujo anterior y ] para
sustituirlo por el siguiente dibujo.
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Capitulo 14: Adicion de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacién esté terminada, puede agregar
efectos, como desenfoques, brillos, sombras, filtros de color y de transparencia, asi como mejorar la calidad
del proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una
capa de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se
aplican al elemento al que estan conectados. Esto proporciona flexibilidad a la hora de decidir a qué
elementos de la escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el drea a
la que deben afectar. El ejemplo mas basico es el efecto de cuchilla. Por si solo, un efecto de cuchilla no tiene
ningun impacto en el dibujo al que estd conectado. Una vez combinado con una capa de mate, el efecto de
cuchilla corta la forma del mate fuera del dibujo.
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Una capa de mate es una capa de dibujo habitual que esta conectada a un efecto como su mate. El efecto toma
la forma del dibujo en la capa de mate para determinar el drea del dibujo a la que afecta. Los colores y detalles
de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En la vista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
que debe afectar.

Si el efecto puede usar una capa de mate, tendrd un pardmetro de mate al ampliar la lista de parametros.
Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el parametro de mate del
efecto para vincularlos.

Si el efecto puede usar una capa de mate, tendrd un puerto de mate a su izquierda al que se puede conectar la
capa de mate.

Una vez que el efecto estd conectado, puede ajustar sus parametros seleccionandolo y, a continuacion,
ajustando sus parametros en la vista de propiedades de capa. También puede hacer doble clic en la capa para
abrir su cuadro de didlogo de propiedades de capa. Si se desea, incluso puede animar los parametros del
efecto convirtiendo sus valores a funciones.

Adicion de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efecto y, a
continuacidn, agregando el efecto a través del menu Add Layers (Agregar capas) de la vista de linea de
tiempo. A continuacion, puede conseguir el efecto previsto ajustando los parametros en la vista de
propiedades de capa y conectandolos a una capa de mate, segun proceda.

Adicion de un efecto
1. En la vista de linea de tiempo, seleccione la capa en la que desee agregar un efecto.

2. Realice una de las siguientes acciones:

* En el mend superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el
efecto que desea agregar.
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e En la barra de herramientas de capas situada encima de la lista de capas, haga clic en
el botén 4+, Add Layers (Agregar capas), seleccione Effects (Efectos) y, a
continuacion, seleccione el efecto que desee agregar.

» Haga clic con el botén derecho en la capa, seleccione Insert > Effects (Insertar >
Efectos) y, a continuacion, seleccione el efecto que desee agregar.

El efecto aparece en la vista de linea de tiempo, debajo de la capa seleccionada.

3. Enlavista de camara, haga clic en el botén Render View (Vista de render) para ver el fotograma
y el efecto actuales renderizados de la escena.

NOTA
El fondo aparecera en negro de forma predeterminada. Para corregirlo, puede

agregar una capa de la carta de color en la parte inferior de la lista de capas 'y
cambiar su color en la vista de propiedades de capa.

4. En la vista de linea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus

propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los parametros disponibles para el efecto

seleccionado.

5. En la vista de propiedades de capa, ajuste los parametros del efecto seguin sea necesario.

NOTA

Cada vez que realice un cambio, la vista de cdmara tendrd que actualizar la imagen
renderizada, lo cual puede provocar una ligera demora antes de que pueda observar el

efecto.
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6. La mayoria de los efectos no se reproduciran en tiempo real en Harmony. Para reproducir la escena
con los efectos finales, haga clic en el boton B Render and Play (Renderizar y reproducir) de la
barra de herramientas de reproduccion de la barra de herramientas de la vista de linea de tiempo.

NOTA

Una vez que haya establecido los parametros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rapidamente sin necesidad de volver a
establecer los parametros; consulte Creacidn y uso de plantillas en la pagina 154.

Uso del efecto de cuchilla

El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptara la forma del dibujo de la capa de mate y
cortard esta forma de la capa de dibujo. Esto es particularmente util si desea que un personaje desaparezca
entre un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Aligual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un pardmetro Inverted
(Invertido), que esta deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchilla tendra el
efecto contrario: en lugar de cortar la forma del mate del dibujo, cortara todo lo que se encuentre fuera de la
forma del mate del dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate. Esto puede ser
util si, por ejemplo, desea dibujar sombras o resaltados para un personaje, pero no desea tener que
preocuparse de que abarquen mas alla del contorno del personaje. Simplemente puede conectar la sombra o
el resaltado a una cuchilla invertida y utilizar un clon del personaje como el mate, y el efecto no se mostrara
fuera de los contornos del personaje.
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Uso del efecto de cuchilla

1. Seleccione una capa de dibujo.

2. Realice una de las siguientes acciones:

» En la barra de herramientas sobre la lista de capas en la vista de linea de tiempo, haga clic
en el botén 4+, Add Layer (Agregar capa) y seleccione Effects > Cutter (Efectos > Cuchilla).

» Haga clic con el botén derecho en la capa y seleccione Insert > Effects > Cutter (Insertar
> Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

1. En la barra de herramientas sobre la lista de capas en la vista de linea de tiempo, haga clic en “%
Add Drawing Layer (Agregar capa de dibujo).

2. Enelcuadro de didlogo Add Drawing Layer (Agregar capa de dibujo), asigne a la nueva capa de
dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuacién, haga
clic en Add and Close (Agregar y cerrar).

3. Enla nueva capa de dibujo de mate, dibuje un mate para el efecto. El mate puede ser una forma
simple, pero se debe rellenar con un color, ya que solo se tendran en cuenta las partes del mate
gue sean opacas.
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NOTA

Los mates también pueden tener dreas semitransparentes. Las areas del dibujo
cubiertas por dreas semitransparentes del mate se ven parcialmente afectadas por el
efecto.

4. En la vista de linea de tiempo, haga clic en el botén + Expand (Expandir) situado a la derecha de la

capa Cutter (Cuchilla).

5. Arrastre y coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo
de la columna Parameters (Parametros).

La capa de dibujo de mate se convierte en el mate de la capa Cutter (Cuchilla). En este punto, las
areas de la ilustracidn que se cruzan con la ilustracion de la capa de dibujo de mate estan ocultas.

6. Sidesea invertir el efecto de cuchilla, para que la ilustracidon que se cruza con la ilustracién de la
capa de mate sea visible y todo lo demas esté oculto, haga doble clic en la capa Cutter (Cuchilla)
(pero no en su nombre) para abrir su cuadro de didlogo de propiedades de capa vy, a continuacion,
marque el parametro Inverted (Invertido).
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Animacion de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede
desear que el radio de un efecto de brillo aumente y disminuya lentamente para hacer que vibre a lo largo de
una escena, o puede desear que la transparencia de un efecto de transparencia aumente de 0 % a 100 % para
hacer desaparecer un dibujo.

Casi todos los pardametros numéricos de un efecto se pueden unir a una funcién. Una funcién permite definir un
parametro para distintos valores en diferentes puntos de la escena agregandole fotogramas clave y
definiendo cada fotograma clave en un valor especifico. Entre fotogramas clave, el valor del parametro
avanzard desde el valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de
dibujo se animan asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar
asociando sus parametros a funciones.

Algunos parametros de efectos se pueden animar directamente en la vista de linea de tiempo, pero no todos.
Al expandir los parametros de un efecto en la vista de linea de tiempo, algunos de sus parametros pueden
estar ocultos para evitar saturar la vista de linea de tiempo. Puede animar esos parametros desde la vista de
propiedades de capa o el cuadro de didlogo de propiedades de capa, que muestra todos los parametros de una
capa.

Animacion de un parametro de efecto en la vista de linea de tiempo

1. En la vista de linea de tiempo, localice el efecto que desea animar y haga clic en el botén 4 Expand
(Expandir) situado a la derecha de su nombre.

nO=am

Aparece en la vista de linea de tiempo la lista de parametros que muestra los parametros de
efectos disponibles.
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En el drea derecha de la vista de linea de tiempo, en la misma fila que el pardmetro que desee
animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animacién para
el efecto.

Cree un fotograma clave realizando una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

En el drea de la izquierda de la vista de linea de tiempo, debajo de la columna Parameters
(Parametros), ajuste el valor del parametro para este fotograma clave realizando una de las
siguientes acciones:

» Haga clic y mantenga pulsado el valor del pardmetro. A continuacién, arrastrelo hacia la
izquierda para reducir su valor o hacia la derecha para aumentarlo.

ro=al
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» Haga clic en el valor del pardmetro. Aparecera un campo de texto. Escriba el nuevo valor del
parametro y pulse Entrar.

5. En el area derecha de la vista de linea de tiempo, haga clic en el fotograma en el que desee crear el
segundo fotograma clave de animacion para el efecto.

6. Cree el segundo fotograma clave para la animacion del efecto realizando una de las siguientes
acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

» Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

7. Enlacolumna Parameters (Parametros), ajuste el valor del parametro en el fotograma clave actual.

8. Repita los pasos para crear tantos fotogramas clave de animacidn para el efecto como sea
necesario.

9. Para ajustar el tiempo entre los fotogramas clave de la animacidn, seleccione el primer fotograma
clave.

10. En la barra de herramientas de linea de tiempo, haga clic en el botédn 4~ Set Ease for Multiple
Parameters (Definir aceleracion para varios parametros).

Aparece el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios
parametros). El grafico de funciones de este cuadro de didlogo se centrard en el primer o
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fotograma clave de la animacion, que debe tener un controlador de la = curva Bézier al lado
apuntando hacia la derecha.

Segundo
fotograma clave

Primer
fotograma
clave

Controlador
de curva
Bézier

11. Haga clic en el controlador de la = curva Bézier y arrastrelo hacia la derecha, en cualquier dngulo,
para ajustar la aceleracion gradual de la animacidn.

12. Haga clic en Apply/Next (Aplicar/siguiente).

El cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracion para varios parametros)
se centrard en el segundo fotograma clave. Si este es el ultimo fotograma clave de la animacidn,
solo tendrd un controlador de curva Bézier apuntando hacia la izquierda. Si hay mas fotogramas
clave de animacion después de este, tendra dos controladores de la curva Bézier, uno apuntando

en cada direccidn.
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13. Haga clic en el controlador izquierdo de la = curva Bézier y arrastrelo hacia la izquierda, en
cualquier dangulo, para ajustar la desaceleracién gradual de la animacidn entre el fotograma clave
anterior y el fotograma clave actual.

14. Sihay un controlador de curva Bézier = apuntando hacia la derecha, haga clic en él y arrastrelo
hacia la derecha, en cualquier dngulo, para ajustar la aceleracién gradual de la animacién entre el
fotograma clave actual y el siguiente fotograma clave.

15. Repita los pasos anteriores hasta que el tiempo de la animacién se ajuste a lo largo de toda la
escena.
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Animacion de un efecto en el cuadro de dialogo de propiedades de capa

1. Abra las propiedades de capa del efecto realizando una de las siguientes acciones:

e Agregue la vista de propiedades de capa a la zona de trabajo y seleccione el efecto en la
vista de linea de tiempo.

» En la vista de linea de tiempo, haga doble clic en la capa del efecto, pero no en su nombre.

2. Enlas propiedades de capa del efecto, localice el parametro que desea animar y haga clic en el
botén .S° Function (Funcidn) situado a su derecha.

El campo de entrada del pardmetro se atenuara. Esto se debe a que no puede editar un parametro
directamente una vez conectado a una funcion. El campo indicara el nombre de la funcién que se
cred para él en este formato:

Nombre de capa: Nombre de funcién: Valor en fotograma actual
3. Haga clic de nuevo en el botdn Function (Funcién) del parametro.

Se abre el cuadro de dialogo Bezier Editor (Editor de Bézier).
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Cursor de fotograma
actual

Grafico de
= funciones

Este cuadro de didlogo permitira animar la funcidn. El grafico de funciones de la parte inferior sirve
para representar los valores de la funcion a lo largo de cada fotograma de la escena.

4. En el grafico de funciones, haga clic y arrastre el cursor rojo ' para moverlo al fotograma donde
desea crear el primer fotograma clave de animacion.

5. Haga clicen el botdn & Add Keyframe (Agregar fotograma clave) para crear el primer fotograma

clave de animacidn para el efecto.

Se crea un fotograma clave o y debe ser visible en el grafico de funciones. Si no se ve, es porque el
grafico de funciones no esta colocado para incluir el fotograma clave en su fotograma. Para mover
el grafico de funciones con el fin de ver el fotograma clave de la funcién, haga clic en el botén ©)
Reset View (Restablecer vista) o @ Reset View Vertically (Restablecer vista vertical).
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6. Ajuste el valor del parametro al fotograma actual realizando una de las siguientes acciones:

* En el campo Value (Valor) sobre el grafico de funciones, escriba el valor deseado para el
parametro.

» En el grafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

:Q’. CONSEJO

Si desea establecer el fotograma clave en un valor que esta fuera del fotograma
del grafico de funciones, puede pulsar la tecla 1 para alejarse. También puede
pulsar la tecla 2 para volver a acercarse.
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7. Hagaclicy arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo
fotograma clave de animacion.

8. Haga clicen el botén ¢+ Add Keyframe (Agregar fotograma clave) para crear el segundo
fotograma clave de animacion para el efecto.

9. Ajuste el valor del parametro al fotograma actual realizando una de las siguientes acciones:

* En el campo Value (Valor) sobre el grafico de funciones, escriba el valor deseado para el
parametro.

» En el grafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

135



Capitulo 14: Adicidn de efectos a una escena

10. Sidesea ajustar el tiempo de la animacion entre el primer y el segundo fotograma clave, haga lo
siguiente:

» Haga clicy arrastre el controlador de la == curva Bézier del primer fotograma clave hacia la
derecha, en cualquier direccidn, para que afecte a la aceleracién gradual de la animacién.

» Haga clicy arrastre el controlador de la <= curva Bézier del segundo fotograma clave hacia la
izquierda, en cualquier direccidn, para que afecte a la desaceleracién gradual de la
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animacion.

11. Repita estos pasos hasta que haya creado y sincronizado los fotogramas clave de animacion
necesarios para animar el efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra como combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguird automaticamente la animacion del personaje, incluso si después cambia la animacién.

Creacion de una sombra paralela para un personaje animado

1. En la vista de linea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje esta bajo un peg maestro, también funcionara si selecciona el peg maestro.

2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asi, haga clic con el
botdn derecho en la seleccidn y, a continuacidn, seleccione Group Selection (Agrupar seleccidn).
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8/ 8 888888

3. Una vez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

» Haga clic con el botdn derecho en la seleccidn y, a continuacion, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y
tiempo).

* En el mend superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempo y la
misma exposicidén que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacién del personaje y la animacién del
personaje clonado se actualizard automaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

* En la barra de herramientas de capas de la vista de linea de tiempo, haga clicen +,
Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

» Haga clic con el botén derecho en la seleccién y, a continuacidn, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. En la vista de linea de tiempo, seleccione la capa raiz del clon del personaje.

6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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* En la barra de herramientas de capas de la vista de linea de tiempo, haga clic en el
botén (% Add Peg (Agregar peg).

e Pulse Ctrl + P (Windows/Linux) o # + P (macOS).

7. Enla vista de linea de tiempo, seleccione el peg padre del clon.

8. En la barra de herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar).

9. En la vista de camara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Capitulo 15: Uso de guias de dibujo

Las guias de dibujo son ayudas para dibujar que puede agregar a su escena para ayudarle a dibujar fondos y
objetos con lineas rectas, angulos rectos y efectos de proyeccidn grafica, como la proyeccion isométrica, la
perspectiva recta y la perspectiva curvilinea. En el arte tradicional, esto se realiza con herramientas, como
reglas, reglas T, escuadras y puntos de desaparicidn. Las guias permiten simular el uso de dichas herramientas
junto con las herramientas de dibujo en Harmony.

Harmony admite distintos tipos de guias de dibujo, cada una disefiada para distintos tipos de tareas de dibujo.
La mayoria de las guias de dibujo de Harmony funcionan agregando una linea de horizonte y puntos de
desaparicidn a su espacio de dibujo. Cuando utiliza una guia de dibujo, aparecen lineas de guia de puntos
mediante el cursor del ratdn. Estas lineas de guia son paralelas o perpendiculares a la linea de horizonte, o van
desde uno de los puntos de desaparicion de la guia hasta el cursor del ratén. Cuando empieza a dibujar un
trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guia, como si dibujara con una
regla. También puede utilizar las guias de dibujo como simples referencias visuales sin fijar la herramienta de
dibujo a los ejes.

Harmony admite los siguientes tipos de guias de dibujo:

» Laregla le permite colocar y rotar un eje y, a continuacion, dibujar una linea a lo largo de dicho eje,
como una regla normal.

* La cuadricula cuadrada le ayuda a dibujar lineas paralelas o perpendiculares a la linea de horizonte.

L

=y
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* |aguia de perspectiva isométrica le ayuda a dibujar lineas paralelas a uno de los tres ejes: el eje x, el
eje vy, y el gje z. EL angulo de cada eje se puede personalizar segin sea necesario.

Este tipo de seudoperspectiva, también conocida como proyeccidn paralela, a menudo se utiliza en
juegos 2D, infografias y esquemas para representar objetos y entornos 3D sin utilizar ninguna
perspectiva, escorzo o renderizado 3D real. En la animacién 2D, a menudo se utiliza para dibujar fondos

de paneo largos desde un dngulo alto o bajo.

» Laguia de perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un Unico punto de
desaparicidn en el centro del horizonte. También le ayuda a dibujar lineas paralelas o perpendiculares a

la linea de horizonte.

Esto es Util para dibujar estructuras de forma de cuboide que se encuentran de cara a la camara.

* La guia de perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
desaparicidn, que se colocan en la linea de horizonte fuera del campo de la camara. También le ayuda a

dibujar lineas perpendiculares a la linea de horizonte.

Esto es Util para dibujar estructuras de forma de cuboide desde un angulo horizontal especifico.
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e Laguia de perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los tres puntos de
desaparicidon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de desaparicion en
la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el eje z. El otro punto
de desaparicién se coloca debajo de la linea de horizonte para ayudarle a dibujar lineas en el gje y.

Esto es Util para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

* |aguia de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar lineas procedentes de uno de los
tres puntos de desapariciéon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de
desaparicidn en la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el
eje z. El otro punto de desaparicién se coloca encima de la linea de horizonte para ayudarle a dibujar
lineasenel ejey.

Esto es util para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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* |Laguia de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panoramicos
horizontales, con lineas horizontales curvilineas. Un punto de desaparicidon se coloca en el centro de la
linea de horizonte para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicién se colocan en
la linea de horizonte fuera del campo de la camara para definir la curva de las lineas horizontales. Las
lineas verticales se colocan perpendicularmente a la linea de horizonte.

Esto es Util para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la
camara sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo horizontal) simulara
una rotacién de la cdmara en el gje v.

]

- : -
__/

e Laguia de perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panoramicos verticales,

con lineas verticales curvilineas. Un punto de desaparicidn se coloca en el centro de la linea de
horizonte para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicidn se colocan debajo de la
linea de horizonte, fuera del campo de la cdmara, para definir la curva de las lineas verticales. Las lineas
horizontales se colocan en paralelo a la linea de horizonte.

Esto es util para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la cdmara
sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo vertical) simulara una rotacion
vertical de la camara en el gje X.
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La guia de perspectiva continua con 4 puntos es muy parecida a la guia de perspectiva con 3 puntos
(paneo horizontal), salvo que esta disefiada para ayudarle a dibujar fondos panoramicos completos de
360°.

Esta guia utiliza 5 puntos de desaparicidon. Cuando dibuja una linea horizontal, se curva formando un
arco sobre uno de los puntos de desaparicion y llegando hasta los dos puntos de desaparicion
circundantes. Esto crea un efecto de perspectiva donde cada punto de desaparicion representa uno de
los puntos cardinales, salvo los puntos mas a la izquierda y mas a la derecha que representan el mismo
punto cardinal, lo que crea un fondo en bucle. Los fondos creados con la guia de perspectiva continua
con 4 puntos se pueden repetir en bucle horizontalmente para simular una rotacion completa de la

camaraen el gjey.

Sur | Este I

La guia de perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la guia de
perspectiva con 2 puntos, salvo que sus lineas verticales son curvilineas, para que se pueda utilizar para
crear fondos de paneo verticales. Dos puntos de desaparicion se encuentran en la linea de horizonte,
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fuera del campo de la cdmara, para ayudarle a dibujar lineas en el eje x y el eje z, y dos puntos de
desaparicidn se colocan encima y debajo del campo de la cdmara para definir la curva de las lineas
verticales.

Esto es util para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de
cuboide se ven desde un angulo.

* |aguia de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilineos en el eje x y en
el eje y. Tiene un punto de desaparicién central en la linea de horizonte desde el que se dibujan lineas
en el eje z; dos puntos de desaparicion en los extremos de su linea de horizonte para definir la curva de
lineas horizontales; y dos puntos de desaparicién encima y debajo de la linea de horizonte para definir la
curva de las lineas verticales.

Esta guia se puede utilizar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo
de pez. También se puede utilizar para dibujar fondos que se deben recorrer en varias direcciones.

145



Capitulo 15: Uso de guias de dibujo

Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias de la escena. Para
familiarizarse con las guias, puede comenzar agregando la guia de dibujo de perspectiva con 1 punto a la lista
de guias.

Adicién de una guia de dibujo de perspectiva con 1 punto a la escena

1. En la barra de herramientas de herramientas, seleccione Herramienta & Brush (Pincel), # Pencil
(Lapiz), (= Stroke (Linea vectorial transparente) o ./ Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de cdmara o de dibujo cuando esta
seleccionada una de las herramientas.

2. Agregue la vista de guias a su espacio de trabajo realizando una de las siguientes acciones:

» En la esquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botén ==
Add View (Agregar vista) y seleccione Guides (Guias).

* En el mend superior, seleccione Windows > Guides (Ventanas > Guias).
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3. Enlavista de guias, haga clic en el boton 4+, New Guide (Nueva guia) y seleccioneE/E 1-Point
Perspective (Perspectiva con 1 punto).

La nueva guia aparece en la lista de guias.

Number of Lines
-

Cuando se agrega una guia nueva, su linea de horizonte se configura en una posicién y un angulo predefinidos
y sus puntos de desaparicidn se configuran en una posicién predefinida. En muchos casos, debe realizar
ajustes en la guia para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guia de perspectiva con 1 punto en una

1. En la barra de herramientas de herramientas, seleccione Herramienta & Brush (Pincel), # Pencil
(Lapiz), (= Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de cdmara o de dibujo cuando esta
seleccionada una de las herramientas.
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2. En lavista de guias, asegurese de que la opcidn Enable Guides (Habilitar guias) esté activada.

3. En la lista de guias, seleccione la guia de {<}-perspectiva con 1 punto en una en la que desee

realizar ajustes.

La guia seleccionada aparece en la vista de cdmara o de dibujo.

I Linea de horizonte I

]

I Punto de desaparicion

4. Realice una de las siguientes acciones:
» Para cambiar la guia de posicién sin rotarla, haga clic y arrastre su punto de desaparicién @.

» Para rotar la guia, haga clic y arrastre su linea de horizonte.

CONSEJOS

e Cuando el ratdn se coloca encima de la linea de horizonte, el cursor del ratdn
cambiard a ) para indicar que estd a punto de rotar la gufa.

» Al rotar una guia, su angulo se muestra en la esquina superior izquierda de la
vista de camara o de dibujo.

5. Una vez que haya terminado de realizar ajustes en la guia, puede hacer clic en el botdn [=»
Lock Guides (Bloquear guias) en la vista de guias para evitar modificar su guia accidentalmente

mientras dibuja.
Una vez que la guia esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guias de dibujo

1. En la vista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

» Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

e Pulse Alt + Mayus + R.
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2. Enla barra de herramientas de herramientas, seleccione Herramienta »” Brush (Pincel), £ Pencil
(Lapiz), (= Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estdn visibles en la vista de cdmara o de dibujo cuando estd
seleccionada una de las herramientas.

3. Enla vista de guias, seleccione la guia que desee usar.

4. Para evitar editar su guia accidentalmente mientras dibuja, haga clic en el botdn =a Lock Guides
(Bloguear guias) en la vista de guias para activarla.

5. Sidesea bloquear sus trazos con los ejes de la guia, asegurese de que la opcién ~#" Align
with Guide (Alinear con guia) de la vista de guias esté activa. En caso contrario, desactivela para
poder dibujar libremente y use solo las guias como referencias.

6. Mueva el cursor del ratdn por el espacio de dibujo. Observe que las lineas de guias pasan por el
cursor del ratén, una por cada uno de los ejes de la guia de dibujo.

7. Comience a dibujar en trazo en el mismo angulo que uno de los ejes.

Si la opcién ~" Align with Guide (Alinear con guia) esta habilitada, el trazo se alinea con el eje mas
cercano a su angulo, como si dibujara con una regla.
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CONSEJOS

* También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las

teclas Flecha izquierda y Flecha derecha para pasar por cada eje. El eje seleccionado
aparecera mas resaltado que los demas. Si pasa por todos los ejes, ninguin eje estara
resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a
determinar en funcién del dngulo de su trazo.

Esté dibujando o no, puede fijar la posicidén y el angulo de las lineas de guia manteniendo
pulsada la tecla Alt. Las lineas de guia dejaran de seguir el cursor del ratdn, lo que le
permitira mantenerlas en un angulo y posicion especificos. Esto se puede utilizar para
dibujar sobre la misma linea varias veces para ajustar su longitud y grosor.

Una vez que haya terminado de trabajar con las guias, puede deshabilitarlas. Cuando las guias de dibujo estan
deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de

dibujo.

Habilitacion y deshabilitacidn de guias de dibujo

1. Para habilitar o deshabilitar las guias de dibujo, realice una de las siguientes acciones:

» En la vista de guias, haga clic en el botdon Enable Guide (Habilitar guia)

e Pulse Mayus + G.

NOTAS

Las guias se habilitan automaticamente al agregar una nueva guia o al seleccionar una
guia en la lista de guias.

La guia que se selecciond cuando deshabilitd las guias se volverd a seleccionar cuando
vuelva a habilitar las guias.

Las guias de dibujo solo funcionan con las herramientas Herramientas &~ Brush (Pincel),
£ Pencil (Lapiz), (- Stroke (Linea vectorial transparente) y / Line (Linea). Si se
selecciona cualquier otra herramienta, las guias de dibujo se comportaran como si
estuvieran deshabilitadas.
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Capitulo 16: Creacion de un multiplano

En la accidn en vivo, cuando la cdmara se mueve alrededor de una escena, parecera que los objetos cercanos a
la camara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacién 2D, se
puede conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje z para agregar profundidad y moviendo la cdmara por el entorno resultante para crear una ilusion de
perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada una representa un objeto que se
encuentra a una distancia diferente de la cdmara. A la izquierda, puede ver cdmo se sitla cada objeto en
relacion con la cdmara, como si estuviera mirdndolos desde un lado. A la derecha, puede ver cdmo se sitdan
las capas en relacidn entre si como si estuviera mirando la escena desde una esquina. A continuacion, puede
ver la escena desde el punto de vista de la cdmara.
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Mediante la herramienta Maintain Size (Mantener tamanfo), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la camara
mientras se ajusta automaticamente el tamafio de la capa proporcionalmente a su distancia de la cdmara,
conservando su tamano aparente desde el punto de vista de la cdmara. Por lo tanto, no tiene que preocuparse
por el tamafio y la posicion de las capas al disefar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacion para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamano)

1. Realice una de las siguientes acciones:

¢ En la barra de herramientas de animacién avanzada, seleccione la herramienta 53
Maintain Size (Mantener tamano).

* En el mend superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamano).

¢ Pulse Alt + 6.
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2. En lavista lateral o superior, seleccione una de las capas de la seccién de imdgenes en miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de camara.

3. Arrastre la capa a lo largo del eje Z dentro del cono de camara.

El elemento se movera en el eje Z de la escena, pero mantendra el mismo tamafio aparente en la
vista de cdmara.
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Capitulo 17: Creacion y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en la vista de linea de tiempo.

Creacion de una plantilla

Creacion de una plantilla

1. En lavista de linea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser til para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. Enlavista de libreria, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendrd una libreria denominada Libreria de Harmony Essentials almacenada en el ordenador, en la
subcarpeta Libreria de Toon Boom Harmony Essentials de la carpeta Documentos.

3. Sila carpeta de libreria esta blogueada, haga clic con el botdn derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre la seleccidn a la carpeta de la libreria elegida.

Library  ==[%

ballerina.tpl

[ATWI

[ AW

Timeline | Node Library

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Haga clic en OK (Aceptar).
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/. CONSEJO

Para cambiar el nombre de una plantilla una vez creada, haga clic en ella con el botén derecho y
seleccione Rename (Cambiar nombre).

Importacion de una plantilla

Importacion de una plantilla

1. En la vista de libreria, seleccione la plantilla que desee importar.

2. Arrastre la plantilla seleccionada a la vista de cdamara o a la izquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdmara, sus capas se agregaran en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertara entre
las capas en las que la colocd.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de
insertar nuevas capas en la escena, esta accién reemplazara los dibujos y los fotogramas clave de
la escena por los de la plantilla. Esto es util para importar plantillas de pose o animacién para los
personajes que ya se encuentran en la escena.
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Tool Properties | Library | 4+[%

[ATWI

Timeline == (%

+ %

X
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Capitulo 18: Exportacion de una pelicula

A través del cuadro de didlogo Export Movie (Exportar pelicula), puede exportar la animaciéon como un archivo
de video. De forma predeterminada, Harmony exportara toda la escena en su resolucién completa. Si lo
prefiere, puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo en una
resolucidon mas pequefia, lo cual puede ser Util si necesita ahorrar tiempo o espacio en disco. En funcién del
formato en el que exporte la pelicula, también puede personalizar los ajustes de compresidn de video y de
audio para mas calidad o para obtener espacio en disco.

Exportacion de un archivo de pelicula

1. En el mend superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

Movie Options

2. En la seccién Output (Salida), abra el menu desplegable Video Format (Formato de video) y
seleccione el formato deseado para su archivo de pelicula:

* QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de
exportacion predeterminado que se recomienda por su portabilidad y porque le
permite elegir entre varios cédecs de video.
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NOTAS

¢ En Windows, se debe instalar QuickTime de Apple para que Harmony

pueda exportar peliculas de QuickTime. Puede configurar que las
peliculas de QuickTime utilicen cualquier cdédec compatible con
QuickTime, incluidos H.264, MPEG-4 y Animation, para su
exportacion.

¢ En macOS, Harmony utiliza Apple AVFoundation para exportar
peliculas de QuickTime, lo que le permite utilizar cddecs como H.264,
Apple ProRes 422 y Apple ProRes 4444, entre otros.

* Sidesea exportar una pelicula de QuickTime con transparencia,
asegurese de elegir un cddec que admita la codificacién con un canal
alfa.

* H.264/MPEG-4 (*.mov): formato de pelicula sencillo que utiliza el cédec H.264
compatible con la mayoria de navegadores web.

NOTAS

¢ Eluso de este formato no requiere software adicional. Sin embargo, si
es la primera vez que exporta una pelicula en formato H.264/MPEG-4,
se le solicitard que descargue la libreria OpenH264 de Cisco.
Simplemente haga clic en Yes (Si) cuando se le solicite y Harmony
descargara la libreria automaticamente y, a continuacién, exportara la
pelicula.

* No hay opciones de codificacién para este formato.

¢ Este formato admite resoluciones de hasta 4096x2304. Cada
dimension debe ser un multiplo de 16 pixeles.

* El audio exportado en este formato esta codificado en PCM estéreo de
16 bitsy 22,05 kHz.

¢ Windows Media Video (*.wmv): formato nativo para Windows Media Player.
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NOTAS

¢ Los archivos Windows Media Video (.wmv) solo se pueden exportar
en Windows.

» Losreproductores de video y editores en sistemas que no sean de
Windows normalmente no pueden abrir archivos Windows Media
Video (.wmv).

3. Haga clic en el botén Browse (Examinar).

4. En el cuadro de dialogo Save (Guardar) que aparece, examine la ubicacion en la que desee exportar
el archivo de pelicula.

5. En el campo File name (Nombre de archivo), escriba el nombre del archivo que desee darle al
archivo de pelicula.

6. Haga clic en Save (Guardar).
7. Enla seccién Export Range (Rango de exportacion), realice una de las siguientes acciones:
e Seleccione All (Todo) si desea renderizar la escena entera.

» Seleccione Frames (Fotogramas) si desea renderizar una parte de la escena. A continuacion,
en el campo de la derecha, introduzca el primer fotograma de la secuencia que desea
exportar, y en el otro campo, el ultimo fotograma de la secuencia que desea renderizar.

8. Abra la lista desplegable Resolution (Resolucidn) y realice una de las siguientes acciones:

» Seleccione Same as Scene Resolution (Igual que resolucidn de escena) si desea exportar
una pelicula con la misma resolucion que la escena.

Height:

» Seleccione 3/4 of Scene Resolution (3/4 de resolucidn de escena), 1/2 of Scene Resolution
(1/2 de resolucién de escena), 1/3 of Scene Resolution (1/3 de resolucion de escena) o 1/4
of Scene Resolution (1/4 de resolucion de escena) si desea exportar una pelicula que sea
inferior a la resolucién de la escena.
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e Seleccione Custom (Personalizado) si desea establecer la resolucion de exportacion
manualmente. A continuacion, en los campos Width (Ancho) y Height (Altura), introduzca
en pixeles la resolucion deseada para su pelicula.

9. Haga clic en OK (Aceptar).

10. En el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clic en
OK (Aceptar).

Aparece una barra de progreso.

11. Desplacese a la ubicacion en el ordenador en la que ha exportado el archivo de pelicula y haga
doble clic en él para verlo en el reproductor de video.

160



Guia de introduccién de Harmony 24 Essentials

Glosario

2D Animation Package

3D estereoscopico

aberracién cromatica

aceleracion

aceleracion de entrada

aceleracién de salida

aceleraciéon gradual

alimentador de papel
automatico

Ancla

animacion

Plugin original para Unity (creado por Unity) que facilita el
procesamiento y la animacién avanzados de sprites 2D (deformaciones,
rigging, teselacion).

Imdgenes o peliculas que generan dos imagenes diferentes, cada uno
desde el punto de vista de uno de los ojos humanos. Cuando se
visualizan o proyectan a través de dispositivos especiales, como una
pantalla 3D o gafas de realidad virtual, se crea la ilusion que los
elementos de la imagen se encuentran enfrente del espectador.

En dptica, una aberracidn cromatica (CA), acromatismo o distorsion
cromatica, es un tipo de distorsion en el que una lente no puede enfocar
todos los colores en el mismo punto de convergencia.

En animacidn, la velocidad es la aceleracién y la desaceleracion de un
movimiento. Puede ser un movimiento creado mediante una curva de
funcidn o una serie de dibujos animados. Otros términos comunes para
aceleracion gradual y desaceleracidon gradual son aceleracién y
desaceleracion.

Aceleracién drastica al principio de la accién.

Aceleracidén dréstica al final de la accion.

Aceleracién gradual en la accidn. Conocida también como aceleracion.

Método automatizado de introducir dibujos en un escaner en el que hay
varios dibujos apilados en un alimentador de hojas. Cuando se activa el
escaner, los dibujos se digitalizan de forma consecutiva, sin ninguna
otra intervencién del usuario.

Los nodos en Harmony pueden marcarse como anclas para exponer su
posicidén, rotacidn y escala en el motor de juego durante el tiempo de
ejecucidn. Los archivos TBG no requieren anclas.

Simulacién de movimiento que se crea dibujando o editando fotogramas
individuales.
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animacion cut-out El proceso conocido como animacion cut-out es la accion de animar
personajes compuestos por varias piezas moviéndolos de fotograma en
fotograma. La animacidn cut-out se puede generar por ordenador o
realizarse del modo tradicional utilizando papel.

animacion directa Técnica en la cual se dibuja por orden una secuencia completa desde la
primera posicién hasta la dltima. Esta metodologia requiere muy poca
planificacién. El lugar en el que el personaje termina y cdmo llega hasta
alli pueden ser una sorpresa tanto para el publico como para el
animador. Este enfoque es espontaneo y creativo, pero puede generar
resultados imprecisos.

animacion pose a pose El proceso de animacion pose a pose es la accién que consiste en crear
todas las poses de accién principales, denominadas poses clave, y
después colocar las poses secundarias entre las claves. Las poses
secundarias se denominan descomposiciéon. Por ultimo, el animador
rellena los huecos con los dibujos intercalados para lograr una
animacion fluida.

animacion secundaria Movimiento secundario provocado por la accién principal. Por ejemplo,
un personaje que corre y lleva puesta una capa. La accidn principal es el
cuerpo que corre. Esto provocara que la capa siga el movimiento,
aungue no se movera al mismo tiempo, sino que reaccionara varios
fotogramas después y seguird la curva de movimiento principal.

animacion sin papel El proceso de animacion sin papel es la accidn de animar digitalmente.
El principal proceso de animacion sin papel es dibujar la animacion,
fotograma a fotograma, directamente en el software.

animacion tradicional Tipo de proceso de animacién mediante el cual todas las secuencias de
animacion se dibujan a mano en papel antes de digitalizarlos o tintarlos
en celdas.
animatica Una pelicula hecha con secuenciacion de paneles en un storyboard, en

la que se establece el tiempo aproximado de cada panel para la accién
que representa y se sincroniza cada panel con la pista de sonido. Las
animaticas se utilizan para convertir el storyboard en un borrador de la
pelicula final con el fin de determinar el tiempo asignado a cada escena
y a cada accidn y sincronizar la accion con la pista de sonido.
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AnimationClip

AnimatorController

anime

Archivo .thg

arco

arrastrar

artista de layout

atajos de teclado

Automatic Importing

Process

baja resolucién

bake_group

Unity Asset que contiene una serie de curvas para diferentes campos de
datos en un prefab (cambios de posicion, rotacién, escala de

Los Animator Controllers deciden qué animacion debe reproducirse
durante la partida en funcién del estado actual del personaje.

Animacion japonesa.

El formato de archivo de juego de Toon Boom (Toon Boom Game o
tbg), se cred a partir de Harmony y Unity lo incorpord, de la misma
forma que en el futuro lo haran otros motores de juego.

La accidon no suele producirse de forma directa, sino que mas bien se
suele desplegar en lo que los narradores denominan un arco. El
propdsito de un arco de historia es mover un personaje o situacion de un
estado o escenario al siguiente.

Operacion que consiste en hacer clic en un elemento, mantenerlo
pulsado y, a continuacion, moverlo mediante el movimiento del cursor
del ratdn. Esto se puede realizar con el botdn izquierdo del ratén o con
la punta del lapiz.

Artista que dibuja el fondo y crea la cdmara y la guia de campo,
haciendo coincidir la escena y el movimiento de la camara. Dibujara en
el modelo las poses de accidn principales.

Tecla de teclado o combinacion de teclas de teclado que se asigna para
realizar un comando especifico en la aplicacion al pulsarlos.

Importara el archivo automaticamente sin intervencion del usuario
cuando el archivo se cree o se modifique/sobrescriba/actualice.

Formato idéneo para videos destinados a la web, donde el tamafioy la
descarga rapida del archivo de video tienen prioridad respecto a la
calidad. Una imagen de baja resolucién es aquella que no contiene
detalles precisos.

Los bake_groups son grupos en la vista de nodos cuyo nombre se
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bocetos

campo

canal alfa

capa

capa de fondo

capa superior

carta de color

carta de exposicion

cambia a «bake_...»; ademas, un bake_group solo admite 1 puerto de
entrada y 1 puerto de salida. Durante la exportacion desde Harmony,
estos grupos se analizan en busca de cambios y se exportan tantos
sprites como variaciones Unicas de datos haya en el grupo, asi como una
animacién para mostrar cada sprite cuando proceda. Dentro de un
bake_group se puede utilizar cualquier efecto: brillos, deformaciones
con forma libre, capa de color/capa de linea.

Es un nombre comun en una pelicula de animacién para un dibujo que
se utiliza como referencia, pero no forma parte de la imagen final. Un
layout es un boceto. Es el esbozo del esqueleto de una animacion o
disefio. Los bocetos consisten principalmente en lineas y formas
esbozadas, pero también pueden contener detalles de disefio.

Unidad de medida que se utiliza en la animacidn tradicional para
registrar y realizar un seguimiento de la camara, asi como de su
proximidad a la escena.

Canal de imagen que contiene informacidn de transparencia. De partida,
una imagen tiene tres canales: rojo, verde y azul (RGB). El canal alfa es
el cuarto canal (A). El mate, o informacion de transparencia, se
almacena en este cuarto canal. Una imagen sin canal alfa siempre es
opaca.

En animacion, una capa es una columna, nivel o personaje individual.
Las capas de una escena estan superpuestas para formar laimagen
final.

En animacidn, una capa de fondo es una parte especifica de la
decoracion colocada detras de la animacidn principal.

Parte del entorno de una escena, como una silla o un arbusto, que se
coloca delante de la animacidn principal.

Una carta de color es una tarjeta que contiene un color sélido con el
mismo tamafio que la camara. La carta de color rellena el fondo con un
color sélido cuando no se ha incluido ninguna imagen de fondo.

Hoja con varias columnas verticales y fotogramas horizontales que se
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carta de fonemas

carta de rodaje

Carta de sprites

celda

ciclo

ciclo de andar

cinematica directa

utiliza para indicar el tiempo de una escena. Cada columna representa
una capa de escena. Los nimeros de dibujos de cada columna se
indican y se repiten a lo largo de la cantidad de fotogramas
determinada en la que deben aparecer. La carta de exposicion la utilizan
los animadores, directores y otros miembros del equipo para trazar la
secuencia y el tiempo de las imagenes, el didlogo, los efectos de sonido,
las pistas de sonido y los movimientos de camara. Conocida también
como carta de rodaje.

Carta basada en los ocho fonemas de la animacion (A,B,C,D,E, F,Gy
X, que se utiliza para representar el silencio) utilizados para la
sincronizacién de labios.

La utilizan los animadores, directores y otros miembros del equipo para
trazar la secuencia y el tiempo de las imagenes, el dialogo, los efectos
de sonido, las pistas de sonido y los movimientos de cdmara. Conocida
también como carta de exposicion.

Varios sprites aplanados en una sola imagen. Algunas cartas estan en
una cuadricula de tamafio fijo y otras tienen sprites de tamanio variable.
EL motor de juego debe entender dénde se encuentra cada sprite en la
carta para poder extraer correctamente los datos de sprite de la carta.

En la animaciodn tradicional, una celda (también denominada celuloide)
es una hoja transparente en la que la animacion se tinta y se pinta antes
de enviarla a la cdmara. El trazado de la imagen se dibuja en la parte
delantera de la celda vy, a continuacidn, se colorea por la parte trasera.

Serie de fotogramas de animacion que se pueden repetir para simular
un movimiento continuo. Por ejemplo, un personaje a menudo camina
mediante una animacion en la que da dos pasos, uno con cada pievy, a
continuacion, repitiendo la animacion.

Serie de dibujos "en el lugar" que describen cémo camina un personaje.
La ilusidon de movimiento se crea utilizando paneos de fondo. Para evitar
realizar innumerables dibujos, los animadores suelen realizar un ciclo
de andar para un personaje.

La cinemdtica directa es una funcién utilizada para animar
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cinematica inversa (IK)

’ s
circulo cromatico

clean up

CMYK

cddigo de tiempo

composicion

corte

corte de salto

principalmente personajes 3D y marionetas cut-out con jerarquia. Se
utiliza para animar una marioneta a partir de una de sus partes padres,
como un hombro, y hacer que el resto del brazo se mueva con ella como
un todo.

Funcién utilizada principalmente para animar personajes 3D y
marionetas cut-out con jerarquia. La cinematica inversa animara una
marioneta desde una de las extremidades, como una mano, y permitird
que el resto del cuerpo la siga con naturalidad.

Visualizacion del espectro de colores en forma de circulo.

Una vez que los bocetos se han evaluado y aprobado, se quita todo el
ruido de la imagen (lineas sobrantes, notas, etc.) para crear dibujos
finales que se pueden tintar, pintar y filmar. El proceso de clean up hace
referencia al trazado de una linea limpia sobre un boceto para conseguir
la versidn final o a la eliminacion de la suciedad y las lineas adicionales
que han quedado tras el proceso de digitalizacion.

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores
forman el modelo estandar utilizado en un proceso denominado
impresion offset.

Informacion de tiempo impresa en un clip de pelicula para indicar la
escena, hora, minuto y segundo que se muestran actualmente en
pantalla.

La composicién es la accion de incorporar todos los elementos de una
escena para crear el resultado final antes del renderizado. Por ejemplo,
el artista de la composicion importara todas las secuencias, el fondo, las
superposiciones y las subcapas de la animacidén en la escena y los
colocara correctamente. A continuacion, el artista definira el encuadre
de camara y lo animara en caso necesario. Por ultimo, el animador
creard todos los efectos generados por ordenador para el proyecto.

Cuando una escena pasa a la escena siguiente de un fotograma a otro
sin ninguin efecto visual.

Corte brusco entre dos escenas. Normalmente, un corte de salto no es
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Create Animator
Controller

curva Bézier

depuracion de sonido

desaceleracién

desaceleracién gradual

descomposicién

desglose de pista de
audio

desplazamiento
pequeno

visualmente agradable. Normalmente lo provoca el final de una escena
y el comienzo de otra, con una imagen parecida. La falta de diferencia
provoca que el ojo vea un pequeno salto entre las dos escenas.

Opcidn para crear un Animator Controller cuando el archivo TBG se
importa por primera vez

Método para definir lineas curvas inventado por el matematico francés
Pierre Bézier. Una curva Bézier es una curva matematica o paramétrica.
Los puntos de control definen las curvas Bézier. En Harmony, las curvas
Bézier tienen un punto de inicio, un punto de final y dos puntos de
control interiores que influyen la curva entre los puntos de inicio y final.

Proceso que permite escuchar el sonido en tiempo real, mientras mueve
el cabezal de reproduccidn hacia delante o hacia atras. Es muy util para
realizar el ajuste preciso de una sincronizacién de labios.

Desaceleracion gradual en la accion. Conocida también como
desaceleracion gradual.

Desaceleracion gradual en la accién. Conocida también como
desaceleracion.

En animacién cut-out, la descomposicién es la accidon de descomponer
un personaje en trozos para crear una marioneta con articulaciones.
Para descomponer un personaje, el artista corta partes, como las manos
y los brazos, del modelo del personaje y las pega en capas
independientes. A continuacidn, las articulaciones se fijan y se definen
los pivotes. En la animacidn tradicional, una descomposicidon es una
pose de animacidn que normalmente se encuentra entre dos poses
clave. Las poses clave son las poses principales de una animacién y las
descomposiciones son poses secundarias que ayudan a describir el
movimiento y la curva de rotacién (normalmente denominada arco).

Desglose de una pista de pelicula animada en sonidos individuales para
generar la posicion fotograma a fotograma precisa de cada sonido.

Pequefio empujon (izquierda, derecha, arriba, abajo, hacia delante o
hacia atras) realizado con las teclas de flecha del teclado en un
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deteccion automatica de
sincronizacion de labios

deteccién manual de

sincronizacion de labios

dialogo

Discretization Step

disefio del personaje

dpi

eje

escena

elemento seleccionado. El desplazamiento pequeio se utiliza para
mover una seleccidn de manera muy ligera y precisa.

Asignacion automatica de dibujos en un elemento a la carta de fonemas
generada para un sonido. Puede ahorrar tiempo al sincronizar los labios
una pista de voz.

Intercambio manual de dibujos de posicidn de la boca para que
coincidan con una pista de voz. Para este proceso, se utilizan tanto la
depuracion de sonido (escuchar una onda de sonido descompuesta
fotograma a fotograma) como las sustituciones de dibujos.

Texto hablado por un personaje en una pelicula o animacién.

El nivel de precision con el que se segmentara un sprite si se deforma.
Cuanto mayor sea el nimero, mas suaves seran las formas de los
sprites que estan muy deformados.

Cada personaje de una pelicula animada se dibuja desde varios dangulos
en formato de estilo pdster denominado hoja de modelo, que sirve
como referencia para los animadores.

Siglas en inglés para puntos por pulgada, que representa la medida
estandar de resolucidn para impresoras computerizadas. En ocasiones
se aplica a pantallas, en cuyo caso es mds exacto denominarlo pixeles
por pulgada. En cualquier caso, el punto es el elemento diferenciado
mas pequefo que forma la imagen.

Linea imaginaria alrededor de la cual rota un objeto. Para graficos 2D,
hay dos ejes: X (horizontal) e Y (vertical). Para gréficos 3D, hay tres ejes:
X (horizontal), Y (vertical) y Z (profundidad). En animaciones que rotan
constantemente, el elemento de eje especifica alrededor de qué eje rota
el objeto. Un nimero negativo provoca que una animacién rote en
sentido contrario a las agujas del reloj, mientras que un nimero positivo
hace que una animacion rote a la derecha.

Plano en una pelicula o programa. Una secuencia esta compuesta por
varias escenas. Una escena cambia a otra mediante un corte simple o
por transicion.
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estilo de paleta

exposicion

FBX

film-1.33

film-1.66

Filter Mode

flipping

Flujo de trabajo de TBG

Flujo de trabajo de XML

fondo

Un estilo de paleta es una segunda version de una paleta existente con
un ligero cambio en el tinte y el valor. Un estilo de paleta se puede
utilizar para crear la version nocturna de una paleta. También se le
puede denominar paleta de clonado.

En animacidn, una exposicién es el nimero de celdas en las que un
dibujo aparece en la escena. Para que un dibujo parezca mas grande, la
exposicidn se debe ampliar durante un nimero de celdas mayor.

Formato de archivo FBX: formato de archivo estdndar en la industria del
modelado 3D y el desarrollo de juegos 3D, popularizado por 3ds Max

Resolucidn idénea para el formato de pelicula panordmico que se ajusta
a la proporcién estandar de 4:3 pixeles.

Resolucién idénea para el formato de pelicula panordmico que se ajusta
a la proporcion de 16:9 pixeles.

Coémo mezclar pixeles contiguos: la opcidn Nearest (Mas cercano)
muestra bordes gruesos alrededor de los pixeles (capa de pixeles),
mientras que Bilinear (Bilineal) y Trilinear (Trilineal) intentan mezclar
los datos de color de los pixeles vecinos para suavizar la imagen.

En la animacidn tradicional, flipping es la accidn de pasar por los dibujos
de una secuencia de animacidon muy rapidamente con el fin de ver la
animacién en movimiento. Flipping también puede ser la accién de crear
una transformacion en espejo de un objeto.

Proceso para exportar un personaje desde Harmony e importarlo a un
motor de juego utilizando archivos TBG como tipo de archivo
intermedio.

Proceso para exportar un personaje desde Harmony e importarlo a un
motor de juego utilizando carpetas XML como tipo de archivo
intermedio.

Ilustraciones que llenan el campo de la cdmara y que se encuentran
detrds de los personajes y props. Normalmente, estas ilustraciones
representan la decoracidn o escena en la que ocurre la accién.
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fonema Unidad de sonido de un idioma.

fotograma Un fotograma de animacidn es una imagen fotografica Unica en una
pelicula. En la animacidn tradicional, el estdndar norteamericano
contiene generalmente 24 fotogramas por segundo, mientras que el
estandar europeo es de 25.

fotograma clave Posiciones importantes en la accién que definen los puntos inicial y final
de cualquier accién. Un fotograma clave es una posicién generada por
ordenador en un momento especifico (fotograma) y en una trayectoria
determinada.

fotograma clave de Fotograma clave con interpolacién generada por ordenador.
movimiento

fotograma clave de Fotograma clave sin interpolacién generada por ordenador.
Stop-motion

fotogramas por Representan la velocidad a la que se reproducen los fotogramas por
segundo segundo. Se calculan por lo general en fotogramas por segundo. Por

ejemplo, una escena se podria reproducir a 12, 24, 25,30 0 60
fotogramas por segundo o a cualquier otro nimero. Es la medida de la
frecuencia (tasa) a la que un dispositivo de imagen produce imagenes
consecutivas Unicas, denominadas fotogramas. El término se aplica por
igual a los gréficos por ordenador, videocdmaras, cdmaras de peliculay
sistemas de captura de movimiento. La tasa de fotogramas se suele
expresar principalmente en fotogramas por segundo (fps) y en
monitores de barrido progresivo en hercios (Hz).

Framerate Numero de fotogramas por segundo que se mostraran al reproducir una
animacion.
funcidén Movimiento, trayectoria o ruta generados por ordenador al que se

pueden conectar parametros de elementos, otras trayectorias y efectos.
La funcidn se puede controlar agregando fotogramas clave y puntos de
control en la curva de funcién.

fundido de El fundido de entrada o fundido de salida es un efecto de transicion
entrada/fundido de utilizado para abrir o cerrar una secuencia. Un fundido de entrada se
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salida

fundido encadenado

gama

guion

HDTV

hoja de campos

hold

HSV

Huesos

Huesos de juego

produce cuando la primera escena aparece progresivamente, desde una
transparencia total a su opacidad total. Un fundido de salida se produce
cuando la escena desaparece progresivamente, desde la opacidad total
a la transparencia total.

Cuando una escena pasa a la escena siguiente mediante un fundido en
el que desaparece una y aparece la siguiente.

Rango de colores que puede representar un dispositivo determinado.

Texto original que contiene la informacion de toda la pelicula o el
programa. En animacion, el guion contiene todas las descripciones de la
ubicacidn, el didlogo, el tiempo, etc. Un proyecto comienza con un guion.

Acrénimo en inglés de television de alta definicidn, que es el estandar
de resolucidn actual para producciones televisivas. La resolucién de
producciones de HDTV es 1280x720 (HD ready) o 1920x1080 (full
HD), y sus fotogramas por segundo normalmente oscilan entre 23.976
y 30.

Guia que contiene todas las unidades de campo que los artistas de
animacién y layout utilizan para definir el tamafio del campo de la
camara, asi como sus movimientos.

Fotograma en la animacién en el cual el personaje mantiene su posicién
sin moverse. Se puede crear un hold entre dos fotogramas clave
cualesquiera.

Siglas en inglés para matiz, saturacion y valor. Método para definir los
colores en cuanto a matiz (tinte), saturacion (sombra) y valor (tono o
luminancia).

Segmentos rigidos del cuerpo de un personaje, utilizados como guia
para deformar un personaje, generalmente las piernas y los brazos.

Deformacién en Harmony que simula el funcionamiento de los huesos
en los motores de juego, parecido a las deformaciones normales de los
huesos en Harmony, pero con un algoritmo de fusidn diferente.
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IK Manager 2D

imagen en miniatura

Importer Settings

ink and paint

Inspector View

intercalado

interpolacién

layout

layout y pose

libreria

linea de accién

Plugin original para Unity (creado por Unity) que facilita la cinematica
inversa (IK) para personajes 2D.

Imagen muy pequena utilizada como una referencia o indicador.

Configuracion disponible en el recurso desde la ventana Inspector que
cambia la forma en que el recurso se convierte de datos en el archivo a
datos que Unity comprende.

El proceso ink and paint es la accidn de pintar las zonas vacias y
colorear las lineas en los dibujos de animacion finales siguiendo un
modelo de color.

Vista en Unity que muestra el contenido de un GameObject: la
transformacidn, componentes para renderizado y fisica, y
comportamientos personalizados.

Dibujos que existen entre las poses clave. Se dibujan para crear
transiciones fluidas entre poses.

Movimiento generado por ordenador creado entre dos fotogramas
clave. Se puede crear interpolacion, o no, entre los fotogramas clave.

Paso de comunicacidn entre el storyboard y la animacién. Es la accion
de poner el storyboard en el modelo. Es decir, el personaje se dibuja
siguiendo el disefio del paquete de modelo, de modo que el animador
puede comenzar a trabajar. El artista de layout dibuja el fondo y crea la
camara y la guia de campo, haciendo coincidir la escena y el movimiento
de la camara. Por ultimo, el animador dibuja en el modelo las poses de
accion principales.

Accidn que consiste en poner el storyboard en el modelo (a la escala
adecuada) para que el animador comience a trabajar.

Zona de almacenamiento que contiene plantillas y recursos que se
pueden reutilizar en un proyecto o escena.

Linea central en una pose de accién. Cuando se pintan poses de accién
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linea de tiempo

lineas vectoriales
transparentes

mapa de bits

Mdscaras

mesa de disco

mesa de luz

MipMap

modelo de color

modelo/modelo de

sin tocar la linea de accidn se garantiza que la pose sea dinamica y que
su silueta se ajuste a la direccion de la accion.

Representacién horizontal de los elementos, el tiempo y los fotogramas
clave de una escena.

Cuando no hacen referencia a trazos reales, las lineas vectoriales
transparentes son contornos invisibles que se utilizan para definir zonas
de color o para cerrar zonas de color abiertas.

Imagen definida por una malla de pixeles, asi como por el color
individual de cada uno de sus pixeles. Los graficos de mapas de bits se
caracterizan por ser preferibles a los graficos vectoriales para
ilustraciones muy detalladas o fotorrealistas. Sin embargo, los graficos
de mapas de bits no se pueden escalar, rotar o sesgar sin que la imagen
pierda calidad.

Colecciones alternativas de dibujos en la linea de tiempo para una capa.
Se pueden crear y alternar utilizando la vista de mascara en Harmony.
Por ejemplo, el traje alternativo de un personaje, que puede cambiarse,
o nuevas partes del cuerpo de un personaje, que se muestran u ocultan
de forma opcional durante el juego.

Equivalente al disco/mesa de animacidn, es un dispositivo que permite
rotar el espacio de trabajo para mayor comodidad mientras se dibuja.

Dispositivo que permite ver otras capas en transparencia mientras
trabaja en una capa determinada.

Cuando MipMap estd marcado en la configuracién de importacion en
Unity, indica que el usuario desea tener versiones de menor resolucién
de las texturas generadas para renderizar a escalas mas
pequefnas/distancias mas lejanas.

Disefio de color oficial que se debe utilizar para pintar la animacién. Un
modelo es el disefio de personaje, prop o ubicacion definitivo que cada
artista debe seguir para la produccién.

Disefio de personaje, prop o ubicacidn definitivo que cada artista debe
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color

morphing

multiplano

NTSC

PAL

paleta maestra

paleta/paleta maestra

panear

panel

papel cebolla

seguir para una produccién. Un modelo de color es el disefio de color
oficial que se debe utilizar para pintar la animacidn.

Funcién que permite crear dibujos generados por ordenador entre un
dibujo de origen y otro de destino. La animacién creada con la funciéon
de morphing se puede reutilizar en distintos proyectos.

Efecto de pasar por diversos niveles de dibujos para crear una
sensacién de profundidad en un plano. Un multiplano es una escena en
la que las capas estan colocadas a distintas distancias de la cdmara, de
modo que, cuando la cdmara se mueve, se produce una ilusién de
profundidad. Con un multiplano, toda la perspectiva y la escala se
calculan automaticamente.

Antiguo sistema de difusion televisiva analdgico estandar utilizado en
Norteamérica.

Resolucién que funciona mejor con el formato europeo para pantallas
de television y de ordenador, ya que los pixeles rectangulares se
muestran con una orientacion distinta.

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza
durante toda la produccidén para mantener la coherencia en el aspecto y
para garantizar que se utilicen los mismos colores durante la
produccién. Conocida también como paleta.

Una paleta o paleta maestra es un grupo de colores atribuidos a un

personaje o prop. La paleta se utiliza durante todo el proyecto para

mantener la coherencia en el aspecto y para evitar cambios de color
durante la animacién. También se le denomina paleta maestra.

Mover la camara atravesando la escena en cualquier direccidn.

En un storyboard, un panel es un fotograma en un plano. Un plano
puede estar compuesto por uno o varios paneles.

Funcién que permite ver los dibujos anterior y siguiente de una
secuencia.
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paso con doble bote

peg

pivote

pixel

planificacién de layout

plano

plano de situacién

En los fotogramas clave y las posiciones de paso de un paso con doble
bote, el cuerpo es menor que una linea de referencia dibujada en
posicién vertical. Durante los intercalados, el cuerpo estd situado sobre
esta linea, ofreciendo asi un aspecto de rebote.

En la animacidn tradicional, es una herramienta utilizada para garantizar
el registro preciso de la accién a medida que se mueven las capas de
celdas. En la animacion digital, en la que se realiza un rigging de
marionetas mas avanzado, se pueden usar capas de pegs. Las capas de
pegs son capas de trayectoria que no contienen dibujos. Son rutas de
movimiento que puede usar para agregar articulaciones de ruta. Para
las ultimas, también puede utilizar una herramienta de cinematica
inversa.

Punto alrededor del cual un peg o dibujo rota.

Elemento mas pequefio de una imagen mostrado en un monitor o
pantalla de televisidn. El pixel, abreviatura en inglés de elemento de
imagen, es un punto Unico en una imagen grafica. Es una pequefia
muestra de una imagen, un punto, un cuadrado o una seccién muy
pequefia compuesta de filtrado suavizado. Si acerca el zoom lo
suficiente en una imagen digital, vera los pixeles, que parecen
pequefios cuadrados de distintos colores e intensidad.

Dibujo de las funciones principales de la escena que se utiliza como
referencia al planificar la animacién y ejecutar sus etapas iniciales.

Escena en una pelicula o programa. Una secuencia esta compuesta por
varios planos. Un plano cambia a otro mediante un corte simple o por
transicion.

Escena en la cual el espectador puede ver toda el drea en la que se estd
produciendo una secuencia. Por ejemplo, si un nifio esta jugando en el
patio delantero de su casa, el plano de situacién seria una escena en la
que el espectador puede ver la casa, el patio, parte de la calle y los
edificios situados alrededor del punto de accién central. Esto ayuda al
espectador a entender la ubicacién de la historia y la orientacién de la
escena.
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plantilla

pose clave

posicion de paso

Prefab

Preview Window

proceso de layout

proporcién

renderizado

Recurso almacenado en la libreria que se puede reutilizar en cualquier
proyecto. Una plantilla puede ser un dibujo, una serie de fotogramas
clave, un archivo de sonido, un panel, un personaje cut-out, un efecto,
una trayectoria, una animacion o cualquier otra cosa que se utilice en la
animacion.

Posiciones importantes en la accién que definen los puntos inicial y final
de cualquier transicion suave. Las claves, o poses clave, son los dibujos
principales de una secuencia de animacion que describen el
movimiento. Por ejemplo, si se agita un brazo, las claves
corresponderan al brazo de una extremidad del movimiento de onday a
la otra extremidad. Al realizar un flipping de dichos dibujos, el animador
puede ver el esqueleto del movimiento sin tener todos los dibujos.

Al dibujar una secuencia en la que un personaje camina, la posicién de
paso es el punto en el que una pierna pasa a la otra.

Jerarquia de GameObjects, transformaciones, componentes y
comportamientos que pueden construirse en la vista de jerarquia y
luego guardarse en la vista de proyectos. Se pueden poner instancias
de prefabs en la jerarquia para tener varios duplicados del mismo objeto
(muchos personajes, muchas balas, muchos arboles).

Seccidn de la pestafa Inspector que muestra el aspecto del recurso,
generalmente con modelos, materiales y texturas.

Paso de comunicacién entre el storyboard y la animacidn.

Proporcidn entre las dimensiones de ancho y altura de una escena,
fotograma o formato de pelicula. Actualmente, la proporcién mas
popular es 16:9. Las pantallas antiguas utilizaban una proporcién de
4:3.

Paso final de la animacion por ordenador. Durante el renderizado, el
ordenador toma cada pixel que aparece en la pantalla y procesa todos
los componentes. Ademds, agrega desenfoque de movimiento antes de
que produzca una imagen final. Es el proceso de calcular las imagenes
finales después del proceso de composicion.
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resolucién

RGB

rigging

rotoscopia

Scene View

secuencia

Shadergraph

simbolo

sincronizacién de labios

Tamanfo de una escena, calculado por lo general en pixeles. Por
ejemplo, la resolucidn NTSC es de 720 x 480. La resolucidn debe
coincidir con la salida final: HDTV, film-1.33, film-1.66, NTSC, PAL,
baja.

Siglas en inglés para rojo, verde y azul. Método que permite definir el
color especificando las cantidades de estos tres componentes del color.

Proceso de conectar las distintas partes de una marioneta cut-out.

Técnica de animacion en la que los animadores trazan un movimiento
de pelicula de accién en vivo, fotograma a fotograma, para usarlo en
peliculas animadas. Es el acto de esbozar sobre material de accién en
Vivo para crear una secuencia animada.

Visualizacién del juego en Unity. Complementa la vista de jerarquia,
donde la Scene View muestra cdmo se vera para un jugador, y la
jerarquia muestra como se ve el juego para el motor.

Serie de escenas o planos que forman una parte distinta de la historia o
pelicula, normalmente conectados por la unién de la ubicacién o el
tiempo.

Formato de archivo de Unity que Unity proporciona con una interfaz de
usuario y un importador de comandos, y que permite la creacion visual y
la edicidn de shaders sin necesidad de escribir cédigo.

Un icono combina animacidn, ilustracidn o capas en un Unico objeto que
puede controlar en una capa. También puede crear iconos de cada parte
del cuerpo en marionetas cut-out. En un icono puede colocar lo que
desee. Puede utilizar simbolos para animar una marioneta o crear
animaciones reutilizables, como un parpadeo.

Proceso que consiste en sincronizar la boca de un personaje con sonidos
en la pista de sonido del didlogo. La boca se ajusta fotograma a
fotograma para hacer coincidir el sonido del didlogo y aparentar que el
personaje esta hablando. La sincronizacion de labios se puede utilizar
para cualquier secuencia de sonido y no solo para el habla. Por ejemplo,
puede hacer que un pajaro pie o que un lobo adulle a la luna.
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slugging

Sombreador

Sprite Atlas

sRGB Texture

Stepped

storyboard

Sub-Asset

tableta/lapiz

TBG

TBG Renderer

Indicacién de los tiempos de inicio y detencidn de un didlogo y las
acciones relevantes.

Instrucciones que informan al juego de cémo mostrar los datos de malla
y textura proporcionados (colores, iluminacion, suavidad, curvatura,
mezcla, etc.)

La versién de Unity de una carta de sprites toma una coleccién de
sprites y los aplana en una sola imagen. Cada sprite del atlas sefalara
los datos en el atlas durante el renderizado, lo que reduce la sobrecarga
de rendimiento de muchos sprites diferentes.

Cuando sRGB esta marcado en la configuracidn de importacion en
Unity, le indica a Unity que los datos en la textura se codificaron en
espacio de color lineal, que coincide con el modo de renderizado lineal
de Unity.

Indica si mantener la animacidn a la frecuencia de fotogramas prevista
por el artista o adivinar los fotogramas intercalados cuando se
muestran a una frecuencia de fotogramas mayor.

Plan visual de todas las escenas y planos de una animacion. EL
storyboard indica lo que sucedera, cuando lo hard y cémo se distribuyen
los objetos en una escena.

Recurso que se empaqueta dentro de un recurso existente, y, por lo
general, se asocia con el recurso principal. En el caso de los archivos
TBG, un personaje consta de un recurso prefab y varios sub-assets para
texturas, sprites, AnimationClips, materiales y TBGStore.

Dispositivo utilizado junto con un ratdn, o en lugar del mismo, para
mover el puntero (en ocasiones denominado cursor) por la pantalla del
ordenador.

El formato de archivo de juego de Toon Boom (Toon Boom Game o
.tbg), se cred a partir de Harmony y Unity lo incorpord, de la misma
forma que en el futuro lo haran otros motores de juego.

Comportamiento en tiempo de ejecucién adjunto a un prefab durante el
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TBG Store

Totales acumulados de
columna

transicion

trayectoria

trazar y pintar

Unity Asset

Unity Custom Importer

usar carta de rodaje

vector

proceso de importacién de TBG que gestiona el cambio de resoluciones,
paletas, mascaras y la actualizacion de los sprites de cuchilla.

Recurso generado durante la importacién de TBG que almacena datos
utiles acerca del personaje a los que el TBG Renderer hace referencia
durante el tiempo de ejecucion.

Campo de texto que contiene informacion de didlogo, efectos, sonido o
slugging en un storyboard.

Efecto colocado entre dos escenas cuando se pasa de una a otra. Los
efectos de transicion comunes son el fundido encadenado y el barrido.

Ruta o trayectoria generada por ordenador que pueden seguir los
elementos. La trayectoria se puede controlar mediante puntos de
control, fotogramas clave y velocidad.

Una vez que los bocetos de las animaciones se han limpiado y se ha
realizado una prueba de linea o de ldpiz final, cada dibujo se traza y se
pinta para la animacidn final. En el mundo digital actual, esto se puede
realizar de maneras distintas a los métodos de celuloide o acetato
tradicionales.

Los fragmentos de datos en Unity, que genera Unity y son nativos de
Unity, y se empaquetan en un juego durante el proceso de creacién del
mismo. Los generan las herramientas de Unity y durante la importacién
de archivos externos.

Importador en Unity que se define en la interfaz de comandos de C# por
proyecto, que asigna una extensién de archivo (p. €j., «.tbg») a un
proceso de conversion de datos de archivo en Unity Assets.

Asignar un dibujo determinado a un rango de fotogramas.

Una imagen basada en vectores esta compuesta por puntos y curvas
Bézier. El ordenador lee los puntos y traza los segmentos,
vinculandolos para reproducir la forma de imagen. Una imagen vectorial
no contiene tamafio fijo ni resolucidn. EL gréfico se puede ampliary
distorsionar seguin se desee y el sistema volvera a calcular los
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velocidad

vibracién de cdmara

XML

Zona

Zonha segura

segmentos y reconstruird las formas. Las imagenes vectoriales se
trasladan y se muestran en pixeles una vez que el calculo se ha
realizado.

En animacidn, la velocidad es la aceleracién o la desaceleracidn de un
movimiento. Se puede alcanzar mediante una curva de funciéon o una
serie de dibujos animados. Otros términos comunes para aceleracién
. .7 . 1
gradual y desaceleracion gradual son aceleracion y desaceleracion.

La vibracién de camara se produce en una escena cuando la camara se
mueve ligeramente y rapidamente en varias direcciones. Este
movimiento da la impresidn de impacto, vibracién o, por ejemplo,
baches en la carretera.

Formato de archivo XML: formato de archivo estandar para almacenar
datos de forma estructural, parecido en su funcionamiento al formato
JSON

Area que se puede pintar con color.

Zona central del fotograma de una escena que no quedara recortada
por el fotograma de TV. Como un fotograma de TV corta un margen del
tamano del fotograma original, al mantener una zona segura se
garantiza que la accidn principal de la escena siga siendo claramente
visible una vez que la pelicula se proyecte en televisidn.
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